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PREFACE

This guide describes how to use the STEP File Analyzer and Viewer, a software tool that analyzes and
generates a spreadsheet or a set of CSV (comma-separated value) files from an ISO 10303 STEP
(STandard for the Exchange of Product model data) file. The spreadsheets simplify inspecting
information in the STEP file at an entity and attribute level. STEP files can also be checked for
conformance to recommended practices for Product and Manufacturing Information (PMI) representation,
PMI presentation, and validation properties.

The STEP File Analyzer and Viewer also generates views of part geometry, graphical PMI annotations,
tessellated part geometry, sketch geometry, supplemental geometry, datum targets, and finite element
models.

More information about the software and sample spreadsheets and views can be found at
https://www.nist.gov/services-resources/software/step-file-analyzer-and-viewer. The source code for the
software is available at https://github.com/usnistgov/SFA.

In this report the acronym SFA will be used for the STEP File Analyzer and Viewer.

UPDATES

For update 7, in addition to some updated figures, new content is found in sections: (3.4) Options tab,
(3.5) Spreadsheets tab, (4.2.1) Saved Views, (4.2.3) Holes, (4.5) Augmented Reality, (5.5.2) Text String
and Numbers, (6.1.3.1) Rounding, and (6.3.1) Semantic Text. The old section 10 was merged into the
renamed section 2.4 Crash Recovery. Some figures are from older versions of SFA.

DISCLAIMERS

Any mention of commercial products in SFA and this User Guide is for information purposes only; it
does not imply recommendation or endorsement by the National Institute of Standards and Technology
(NIST). For any of the web links in the software and this User Guide, NIST does not necessarily endorse
the views expressed, or concur with the facts presented on those web sites.

NIST-developed software is provided by NIST as a public service. You may use, copy and distribute
copies of the software in any medium, provided that you keep intact this entire notice. You may improve,
modify and create derivative works of the software or any portion of the software, and you may copy and
distribute such modifications or works. Modified works should carry a notice stating that you changed
the software and should note the date and nature of any such change. Please explicitly acknowledge the
National Institute of Standards and Technology as the source of the software.

Please also refer to the NIST Disclaimer and the NIST Software Disclaimer.

ACKNOWLEDGEMENTS

Dr. Soonjo Kwon, a former guest research at NIST now at the Kumoh National Institute of Technology in
South Korea, developed the software that converts STEP to X3D [1] for viewing part geometry as
described in Sec. 4.1.

The image on the cover page was generated by SFA from a STEP file downloaded from GrabCAD
https://grabcad.com/library/gtcp85-98d-1.
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1 Introduction

The STEP File Analyzer and Viewer [2] processes STEP (ISO 10303 — informally known as the
STandard for Exchange of Product model data) [3, 4] files. A STEP file refers to a file that is typically
exported by CAD (Computer-Aided Design) software in a format described by ISO 10303-21 and known
as a Part 21 file [5, 6].

In this report the acronym SFA is used for the STEP File Analyzer and Viewer.

SFA supports current and some older editions of the following STEP Application Protocols (AP), also
known as STEP schemas. An AP is the implementable part of ISO 10303 upon which STEP import and
export translators are based on for a particular engineering domain. A complete list of supported APs can
be found in the SFA Help menu under Supported STEP APs.

e AP203 — Configuration Controlled 3D Design of Mechanical Parts and Assemblies [7], the older
version of AP203 is known as Config Control Design

e AP209 — Multidisciplinary Analysis and Design [8, 9], the older version of AP209 is known as
Structural Analysis Design

o AP210 - Electronic Assembly Interconnect and Packaging Design [10]

e AP214 — Automotive Design [11]

e AP238 — Model Based Integrated Manufacturing Schema [12, 13], the older version of AP238 is
known as Integrated CNC Schema

e AP239 — Product Life Cycle Support (PLCS) [14, 15]

e AP242 — Managed Model Based 3D Engineering [16-18]

Some other schemas are also supported.
e [SO 13399 Cutting Tools Data [19]
e ISO 13584 Parts Library (PLIB) [20]
e [FC (Industry Foundation Classes) [21-23]
e CIS/2 (CIMsteel Integration Standards) [24, 25]

There are four main features of SFA.

1. SFA is a viewer for parts, sketch and supplemental geometry, graphical PMI annotations, tessellated
part geometry, datum target, and finite element models. The viewer is described in section 4.

2. SFA generates a spreadsheet or a set of CSV (comma-separated value) files from a STEP file. The
spreadsheets or CSV files simplify inspecting information from the STEP file at an entity and
attribute level. Spreadsheets are described in section 5.

3. SFA can also analyze a STEP file for conformance to recommended practices for Product and
Manufacturing Information representation (semantic PMI), PMI presentation (graphical PMI), and
validation properties. Recommended practices are defined by the CAx Interoperability Forum
(CAx-IF) [26]. Checking recommended practices is described in section 6.

4. SFA can check for basic syntax errors and warnings in STEP files related to missing or extra
attributes, incompatible and unresolved entity references, select value types, illegal and unexpected
characters, and other problems with entity attributes. Some errors might prevent SFA and other
software from processing a STEP file. The syntax checker is described in section 7.



2 Getting Started

2.1 Install SFA

SFA runs on Windows 7 or higher computers. The viewer for part geometry (Sec. 4.1) requires a 64-bit
computer. Microsoft Excel is required to generate a spreadsheet. Excel 2007 and higher is supported. If
Excel is not installed, then CSV files will be generated instead of a spreadsheet.

The link to the download request form for SFA can be found on
https://www.nist.gov/services-resources/software/step-file-analyzer-and-viewer. You will receive
instructions about where to download SFA after submitting the download request. SFA is downloaded as
a zip file named SFA-n.nn.zip where n.nn is the version number.

The installation process does not require anything more than unzipping SFA-n.nn.zip. The zip file
contains six files:

STEP-File-Analyzer.exe — Graphical user interface (GUI) version of SFA
STEP-File-Analyzer-CL.exe — Command-line version (Sec. 9)
SFA-User-Guide-v7.pdf — User Guide

SFA-README-FIRST.pdf — Readme file

STEP-File-Analyzer-changelog.xlsx — Summary of new and updated features
nist_ctc_05.stp — Sample STEP AP242 file with semantic PMI

AR o

There are no restrictions as to where the files are located on your computer’s file system.

2.2 Run SFA

To run SFA, simply double click on the icon for STEP-File-Analyzer.exe. Several setup functions are
performed the first time you run SFA:

Welcome message is shown in the Status tab.

Option to create a shortcut in the Start Menu and an icon on the Desktop.

User Guide is opened.

Crash Recovery dialog is shown (Sec. 2.4).

STEP-File-Analyzer-options.dat is created in your home directory that stores the current state of
SFA options. Do not edit this file.

6. Installation of the IFCsvr toolkit.

SR =

2.2.1 Install IFCsvr

Although the IFCsvr toolkit' was originally written to process IFC files [21] used in the building and
construction industry, it has been adapted to read and process STEP files. The IFCsvr installation program
is automatically started. You might need administrator privileges to install the toolkit. The installation
program might cause antivirus software to respond that there is an issue with the toolkit. The toolkit is
safe to install. For example, if the Windows Defender antivirus software responds that there is an issue
with the toolkit, select More Info and Run Anyway.

Two of several installation dialogs are shown in Figure 1. Use the default installation folder as shown in
the right dialog. You must let the installation process complete before processing any STEP files.

! The IFCsvr toolkit used to be available in a Yahoo Group.
https://web.archive.org/web/20090726182959/tech.groups.yahoo.com/group/ifcsvr-users/



https://www.nist.gov/services-resources/software/step-file-analyzer-and-viewer
https://web.archive.org/web/20090726182959/tech.groups.yahoo.com/group/ifcsvr-users/

3} IFCsvrR300 ActiveX Companent = S 5 IFCsviR300 ActiveX Companent

Welcome to the IFCswrR300 ActiveX Component

‘ Select Installation Folder
Setup Wizard =

The installer will guide you through the steps required to install IFCewR300 ActiveX Component on The installer will install IFCswrR300 Activex Componentto the following falder.
waur camputer.
Toinstall in this folder. click "Mext”. To install to a different folder. enter it below or click "Browse".

Eolder:

CAProgram Files (x860,FCswrR3004 Browse
Disk Cost
WARNING: This computer program is protected by copyright law and international treaties. Install IFCswrR300 ActiveX Component for yourself, or for anyone who uses this computer
Unauthorized duplication or distribution of this program, or any portion of it. may resultin severe civil
or criminal penalties, and will be prosecuted to the maximurm extent possible under the law.
Q! Everyone
Justme
Cancel <Back | camcel | [ cBack [ wew

Figure 1: IFCsvr installation dialogs

Sometimes an updated version of SFA will prompt you to reinstall [FCsvr to update the STEP schemas.
This requires removing the existing version of IFCsvr and installing the new version.

If you Cancel the IFCsvr toolkit installation, you will still be able to user the Viewer for Part Geometry
(Sec. 4.1). Select View and Part Only in the Generate section of the Options tab (Sec. 3.4.1).

2.3 Generate Output

After the [FCsvr toolkit is installed, you can generate a spreadsheet and view from a STEP file. Go to the
File menu, select Open STEP File(s), select a STEP file on your computer, click Open in the dialog, and
then click on the Generate Spreadsheet and View button.

Feedback will appear in the Status tab indicating the progress of processing the STEP file. The
spreadsheet will be opened after it has been generated and the view will open in the default web browser.
If CSV files are generated, the directory where the CSV files were generated will be opened. One CSV
file is generated for each entity type.

2.4 Crash Recovery

Sometimes SFA will unexpectedly stop (crash) when processing a STEP file. This is usually due to either
bugs in the STEP file or limitations of the IFCsvr toolkit. If this happens, simply restart SFA and process
the same STEP file again by using function key F1 or F6 if processing multiple STEP files. SFA keeps
track of which entity type caused the crash for a particular STEP file and will not process that type again.
A message will be shown in the Status tab if a particular type of entity will not be processed.

Use the Syntax Checker (Sec. 7) to check for syntax errors and warnings related to entities that might
have caused the crash.

The entity types that will not be processed again are stored in a file myfile-skip.dat. No matter what the
reason is for the crash, that file will always be generated. Even if you stop SFA in the middle of
processing a STEP file, the file *-skip.dat will be generated. Therefore, the next time SFA is run, the
entity type that was being processed when you stopped SFA will not be processed. In this case, or if the
syntax errors related to the bad entity are corrected, the *-skip.dat file can be deleted or edited.




Another way to prevent that entity type from being processed is to deselect, in the Process section of the
Options tab, the category of entities that contains the entity that caused the crash. That will prevent that
entity from being processed along, however, with all other entities of that category.

SFA might also crash when processing very large STEP files. Popup dialogs might appear that say,
“unable to alloc xxx bytes”. In this case, deselect some entity types to process in the Options tab or use a

User-Defined List of entities to process (Sec. 3.4.2).

Figure 2 shows the Crash Recovery dialog that is shown the first time SFA is run.

M) What to do if the STEP File Analyzer and Viewer crashes? >

Sometimes the STEP File Analyzer and Viewer crashes AFTER a
file has been successfully opened and the processing of
entities has started.

A crash is most likely due to syntax errors inthe STEP file or
sometimes due to limitations of the toolkit used to read STEP
files. Run the Syntax Checker from the Options tab or
function key F2 to check for errors with entities that might
have caused the crash, See Help = Syntax Checker

The software might also crash when processing very large
STEP files. See Help = Large STEP Files

Pore details about recovering from a crash are explained in
Help = Crash Recovery.

Figure 2: What to do if the STEP File Analyzer and Viewer crashes

2.5 Uninstall SFA

SFA can be uninstalled by manually deleting the two executable files and PDF files, the STEP-File-
Analyzer-options.dat file in your home directory, and the desktop icon for SFA. The IFCsvr toolkit can
also be deleted from Apps in Windows Settings. Temporary files can also be deleted from
C:/Users/username/AppData/Local/Temp/SFA.



3 User Interface

Figure 3 shows the SFA user interface on a computer running Windows 10. At the top of the user
interface is the Menu bar with the File, Websites, Examples, and Help menus. Below that is the Tabs bar
with tabs for Status, Options, and Spreadsheet. Below that is the Status window that shows text feedback
when SFA is running. Clicking on the Options and Spreadsheet tabs will switch to the user interface for
those tabs. At the bottom of the user interface is the Generate Spreadsheet and View button, NIST logo,

and progress bar.

File Websites Examples Help
Status  Options Spreadsheet

ra=r STEP File Analyzer and Viewer - O x

Opening STEP AP242 file
13394 entities
This file contains: Datum targets, Datums, Dimensions, Geometric tolerances, Graphical PMI

Generating Header worksheet

Name: nist_ctc_85

FileDirectory: C:%Usersilipman\Documentsh\Analyzer)

FileDescription: CTC-85 geometry with PMI representation and/or presentation, from the NIS
FileImplementationLevel: 2;1

FileTimeStamp: 2028-81-24T11:83:21+81:88@

FileAuthor:

FileOrganization:

FilePreprocessorVersion:

FileOriginatingSystem:

FileAuthorisation:

Schemalame: AP242 MANAGED MODEL_BASED 3D ENGIMEERING MIM_LF {1 @ 1@3@3 442 1 1 4 } (Editio

Standards:
I50 16792

Generating STEP Entity worksheets
dimensional_characteristic_representation (6)
Adding PMI Representation Analysis

Dimension units: IMCH

datum (4)

datum_feature (2)

Adding PMI Representation Analysis
datum_reference_compartment (35)

Adding PMI Representation Analysis
datum_reference_element (2)

Adding PMI Representation Analysis
datum_system (5)

Adding PMI Representation Analysis
dimensional_location (5)

dimensional_size (1)

< >

NIST

| Generate Spreadsheet and View | National Institute of
H I i Standards and Technalogy
U.5. Department of Commerce

Figure 3: User interface

< Menu bar
< Tabs bar

< Status tab with
text feedback

< Generate
button

< Progress bar



3.1 Menu Bar

The menu bar contains four items: File, Websites, Examples, and Help menus.

3.1.1 File Menu

From the File menu, shown in Figure 4, you can select a single STEP file to process with
Open STEP File(s). STEP files with extensions of .stp, .step, and .p21 are recognized. Compressed STEP
files with an extension of .stpZ are also recognized. ISO 10303 Part 21 Edition 3 STEP files are also
supported [5, 27] (Sec. 5.6). AP238 files with a .stpnc file extension are supported if the file extension is
changed to .stp.

Multiple STEP files can be processed at one time by selecting the Open Multiple STEP Files in a Directory
option where you will be asked to select a directory to search for STEP files. The search for multiple files
can be restricted to only the selected directory or to include all subdirectories.

Multiple STEP files can also be selected in the Open STEP File(s) dialog by holding down the control or
shift key when selecting files. When spreadsheets from multiple STEP files are generated, a File
Summary spreadsheet is also generated as described in Sec. 8.1.

Below the first solid line in the File menu is a list of up to 24 of the most recently translated STEP files
that can be opened directly. Function keys, defined in the Help menu, can be used to access features of
the File menu and other functions.

o=t STEP File Analyzer and Viewer
File Websites Examples Help

Open STEP File(s)... Ctrl+0
Open Multiple STEP Files in a Directory... Ctrl+D, F&
ChAAnalyzernist_cte_05.stp F1

Ch A Chx-IPVRAS 48] _pmi-t\FTC 10%pmi_10-e5-242.stp
Ch. ACAx-IPVSTEP Files\MIST\nist_ftc_08_asmel_ap2d42-el-tg.stp
Ch AMIST mite crada assembly MX19533WMIST_mtc_crada_STEPYS0591A4141 HEX NUT.stp

Open Spreadsheet F2
Open View File F3
Open Multiple File Summary Spreadsheet F7
Exit Ctrl+Q

Figure 4: File menu



3.1.2 Websites Menu
The Websites menu, shown in Figure 5, provides links to useful resources related to SFA, NIST research,
CAXx-IF resources, AP242, related organizations, and the STEP format, schemas, and software.

WebsitesJ/\&Examples Help
STEP File Analyzer and Viewer 3
Conformance Checking of PMI in STEP Files
MEE PMI Validation and Comformance Testing
Product Definitions in Augmented Reality

Chx Interoperability Forum (CAx-IF)
Chx Recommended Practices

CAD Implementations

STEP File Viewers

AP203 vs AP214 ws AP242
Ap242

STEP Format and Schemas
STEP Software

STEP Related Organizations

T vy v v

Figure 5: Websites menu

3.1.3 Examples Menu
The Examples menu, shown in Figure 6, has links to several sources of sample STEP files and sample
views and spreadsheets generated by SFA.

Examples  Help
Sample STEP Files (zip) 1
STEP File Library
Archived STEP Files

View Box Assembly

Part with PMI

AP242 Tessellated Part with PMI
AP209 Finite Element Model

Spreadsheet - PMI Representation
PMI Presentation, Validation Properties
PMI Coverage Analysis

Figure 6: Examples menu



3.1.4 Help Menu

The main Help Menu, shown in Figure 7, has five sections and two submenus. User Guide a link to this
document. Changelog opens the spreadsheet of changes for each version of SFA. Check for Update
opens up a web page that checks for the latest version of SFA. Follow the instructions on that web page
to download a new version of SFA if one is available. This feature runs automatically if an update has
not been checked for in the last 30 days.

The other topics in the Help menu show information in the Status tab and are similar to most information
in this User Guide. The submenus have information about View and Analyze options.

e N
User Guide 1 .
What's New M ——————————————————
Changelog Analyze 9 Graphical PMI
Check for Update _ Supplemental Geometry
E— Eu”m':'gh}{ef Datumn Targets
) S ec. er. AP242 Tessellated Part Geomnetry
Options Open STEP Filein App | Ap209 Finite Element Model
Viewer Multiple STEP Files Holes
View b Supported STEP APs r
Analyze s
Function Keys e b |
Syntax Checker m ———————————————————
Open STEP File in App by Validation Properties
Multiple STEP Files = PMI Representation (Semantic PMI)
Supported STEP APs Syntax Checker PMI Presentation (Graphical PMI)
Text Strings and Numbers Open STEP Filein App PMI Coverage Analysis
Large STEP Files Multiple STEP Files Syntax Errors
Crash Recovery Supported STEP APs NIST CAD Models
Text Strings r
Disclaimers
MIST Disclaimer
About

Figure 7: Help menus



Help is also available in the form of tooltips related to some of options in the tabs. Holding the mouse
over any text in a tab for a second or two will show a tooltip. The Spreadsheet tooltip help in the Options
tab is shown in Figure 8.

Spreadsheet [ ] CSV Files View [ ]| Part Only ] Syntax Checking !

P Spreadsheets contain one worksheet for each STEP entity type. Process categories

below control which STEP entity types are written to the Spreadsheet and/or C5V
files. Analyze options below also write information to the Spreadsheet,

If Excel is installed, then Spreadsheets and CSV files can be generated. If C5V Files
is selected, the Spreadsheet is also generated. C5V files do not contain any cell
[l colors, comments, or links, GD&T symbels in C5V files are only supported with
Excel 2016 or newer.

If Excel is not installed, only CSV files can be generated. Options for Analyze and

Inverse Relationships are disabled. i
J&m L7 = e = —

Figure 8: Tooltip help

3.2 Tabs Bar

The Tabs bar is located directly below the menu bar in Figure 3. Clicking on a tab will switch from the
current tab to the selected tab. Except for the Status tab, the tabs contain the options that affect how a
spreadsheet and view is generated from a STEP file. The Options and Spreadsheet tabs are described in
Secs. 3.4 and 3.5, respectively.

3.3 Status Tab

The Status tab shows important feedback during the generation of a spreadsheet from a STEP file. You
should not ignore the feedback as it provides useful information related to the success in processing the
STEP file. Some of the error, warning, or informational messages in the Status tab have a yellow
background, _, red, blue, or green text. Syntax error messages highlighted with a red
background are for nonconformance of some aspect of the STEP file to a CAx-IF recommended practice
[28]. Information in the Status tab is shown in Figure 3 and Sec. 6.5.



3.4 Options Tab

Figure 9 shows the Options tab with five sections to control what type of output is generated from a STEP
file.

ra=r STEP File Analyzer and Viewer — O >
File 'Websites Examples Help
Status Options  Spreadsheet

Generate
Spreadsheet [ ] CSV Files View [ PartOnly  [] Syntax Checking Log File Open Output Files
Process
Commaon Measure AP242 Composites ) Al
Presentation Shape Aspect  [] Geometry Features () Reset
Representation Tolerance [ Coordinates Kinematics
[] User-Defined List: |C:/Users/lipman/Documents/Analyzer/IFAfuserlist.bet Browse
Analyze View
All All
Walidation Properties Part Geometry Edges Sketch [ ] Mormals
AP242 PMI Representation (Semantic PMI) Quality: @) Low (O Mermal ) High
[] Round dimensions and geometric tolerances Graphical PMI Saved View Viewpoints
PMI Presentation (Graphical PMI) PMI Celor: () From File ) Black ® By View ) Randem
] Presentation Coverage AP242 Tessellated Part Geometry Wireframe
[ Inverse Relationships and Backwards References AP209 Finite Element Model  [] Boundary conditions
[] Leads Scale loads [ Displacements Mo vector tail
Open STEP File in App
| Default STEP Viewer v Open

Figure 9: Options tab

3.4.1 Generate
A Spreadsheet (Sec. 5) and/or View (Sec. 4) can be generated from a STEP file.

If Excel is installed, then a spreadsheet and CSV files can be generated. If Excel is not installed, only
CSV files can be generated, and some features are not available such as Analysis reports (Sec. 6). CSV
files do not contain any cell colors, comments, or links. For CSV files, PMI annotations will look correct
only with Excel 2016 or newer.

The Syntax Checker can be run when processing a STEP file (Sec. 7).

Text in the Status tab can be saved in a log file named myfile-sfa.log. In the log file, color-coded
messages in the Status tab (Sec. 3.3) are preceded by two or three asterisks (*).
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3.4.2 Selectively Process Entity Types

SFA can process any entity type for any schema listed by Supported STEP APs in the Help menu. The
checkboxes in the Process section of the Options tab allow you to selectively process different types of
entities. Each checkbox corresponds to a category of entities that is also used to group and color-code
entities on the File Summary worksheet as shown in Figure 38.

All entities unique to APs and schemas other than AP203, AP214, and AP242 are always processed. The
All button selects all categories except Geometry and Coordinates. The Reset button deselects all
categories, except Common.

Selecting any Analyze option automatically includes the necessary entity categories related to that
analysis. For example, selecting the analysis for AP242 PMI Representation automatically selects the
entity categories for Common, Representation, Measure, Shape Aspect, and Tolerance, and disables
deselecting them.

Holding your mouse over the checkboxes for a second or two will show a tooltip that lists all of the
entities in that category. The tooltip for the Shape Aspect entities is shown in Figure 10 and shows that
there are 60 entities in the Shape Aspect category. The first set of entities are found in STEP AP203,
AP214, and AP242. The second set of entities is only in AP242 with some only in AP242 edition 2.

hape Aspect [ Geometry [] Features (") Reset

[] Zolaranca [1 Ceordinatar [] Kinematiec
Shape Aspect entities (B0) are found in most STEP APs,

apex centre_of_symmetry composite_shape_aspect derived_shape_aspect directed_angle extension geometric_alignment
geometric_intersection geometric_iter_specific_usage itermn_identified_representation_usage joggle_termination parallel_offset
perpendicular_to placed_feature shape_aspect shape_aspect_associativity shape_aspect_deriving_relationship
shape_aspect_relationship shape_aspect_transition symmetric_shape_aspect tangent

Fties
Lent The following entities are found only in 4P242. Entities marked with a * are only in AP242 edition 2.
nsion all_around_shape_aspect assembly_bond_definition assembly_joint assembly_shape_constraint® assembly_shape_joint*
between_shape_aspect chain_based_geometric_item_specific_usage component_feature component_feature joint
component_mating_constraint_cenditiocn component_path_shape_aspect component_terminal composite_group_shape_aspect
(G'Ecomposite_unit_shape_aspect connection_zone_based_assembly_joint connection_zone_interface_plane_relationship
Cov{connectivity_definition® constituent_shape_aspect® contact_feature® contacting_feature continuous_shape_aspect
cross_sectional_alternative_shape_element®™ cross_sectional_group_shape_elerment™
cross_sectional_group_shape_element_with_lacing™ cross_sectional_group_shape_element_with_tubular_cowver®
cross_sectional_occurrence_shape_element™ cross_sectional_part_shape_element® geometric_contact harness_node®
harness_segment™ physical_component_feature physical_component_interface_terminal® physical_component_terminal
shape_aspect_occurrence™ shape_aspect_relationship_representation_asscciation terminal_feature™ terminal_location_group™
transport_feature® twisted_cross_sectional_group_shape_element™

ions

hips

PP

Figure 10: Tooltip help for Shape Aspect entities

A User-Defined List can also be used to set which entities will be processed. The list is defined in a plain
text file with the name of one entity type per line in lower case. When the User-Defined List option is
selected, the Browse button will be activated to select the file that contains the list of entities. This option
allows you more control to process only the required entity types. It is also useful when processing large
STEP files that might crash SFA.
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3.4.3 Analysis Reports

SFA checks the STEP file for conformance to recommended practices which are specifications that
provide common implementation guidance associated with specific functionalities for data exchange.
The CAx-IF has published recommended practices for communicating PMI representation, PMI
presentation, and validation properties in STEP files [28]. Recommended practices are not part of ISO
10303 EXPRESS schemas [29, 30].

Non-conformance to recommended practices is shown with messages in the Status tab and spreadsheet
cells that are highlighted in red.

Section 6.1 discusses the report for PMI representation. Section 6.2 discusses the report for PMI
presentation. Section 6.3 discusses the report for validation properties.

3.4.4 View Options
Views for part geometry, graphical PMI annotations, AP242 tessellated part geometry, and AP209 finite
element models can be generated. Section 4 describes the view options.

3.4.5 Open STEP File in App

The Open STEP File in App option is a convenient way to open a STEP file in other applications. Figure
11 shows the pull-down menu listing some of the applications that can open a STEP file on the author’s
computer. The pull-down menu will always contain a text editor, Default STEP Viewer, and
Tree View (for debugging) which is described below. The Default STEP Viewer is whichever application
is associated with STEP files (.stp file extension). Several STEP file viewers and conformance checkers
also appear in the pull-down menu. Applications will appear in the pull-down menu if they are installed
in their default location. To open a STEP file in one of the applications, select the application from the
pull-down menu and click the Open button.

Open STEP File in App
Default STEP Viewer w Open

Default STEP Viewer "

Tree View (for debugging)
Motepad++

C3D Viewer

eDrawings Pro

IDA-STEP Viewer

CAD Assistant

VariCAD Viewer

EDM Meodel Checker 3

FreeCAD 019 W

Figure 11: Open STEP File in other applications
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3.45.1 Tree View for Debugging

The option for the Tree View (for debugging) will show the STEP file in a text editor; however, the STEP
entities will be rearranged and indented to show the hierarchy of information in the STEP file. This is a
useful feature to help debug a STEP file, however it is not recommended for large STEP files. Figure 12
shows a sample of the tree view output. In this sample, it is easy to see how flatness_tolerance (#5584)
refers to length_measure_with_unit (#5585) and datum_feature (#5583). The tree view output of the
STEP file starts with entities that will generate useful output and stops with other entities to prevent the
tree view file from getting too large. Basic geometric and styled item entities can optionally be included
in the tree view file, which will increase the size of the file. The resulting tree view file is named
myfile-sfa.txt

#5584=FLATNESS TOLERANCE("GT1",%,#5585,#5583);
#5585=LENGTH_MEASURE_WITH UNIT({LENGTH MEASURE(®.82),#24);
#24=(LENGTH_UNIT( )NAMED UNIT(*)SI UNIT(.MILLI.,.METRE.));
#5583=DATUM FEATURE('Fl116',%,#37,.T.);
#37=PRODUCT _DEFINITION SHAPE('Mone','None®,#36);
#36=PRODUCT_DEFINITION( 'None®, 'None',#34,#35);
#34=PRODUCT_DEFINITION FORMATION('®,'None',#32);
#32=PRODUCT( 'GDT_Test Part 2811 1-id","'", 'None",(#12273));
#12273=PRODUCT _CONTEXT({ 'part”,#29,"'");
#29=APPLICATION CONTEXT('automotive design');
#35=PRODUCT_DEFINITION_CONTEXT('part definition®,#29, 'design’);

Figure 12: Tree View output
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3.5 Spreadsheet Tab

The Spreadsheet tab, shown in Figure 13, contains several more options that affect how information is
written to the spreadsheet.

re=r STEP File Analyzer and Viewer
File Websites Examples Help
Status Options Spreadsheet

Maximum Rows
100 O os00 (@ 1000 ) s000 O 10000 (O s0000 D 100000 () Maximum

Formatting
Process Text Strings with syrmbols and non-English characters
[] Generate Tables for sorting and filtering

[] Do not round real numbers in spreadsheet cells

Other

[] Save X3D file generated by the Viewer

(] Show frustrum for Saved View Viewpaoints

[] Show all PMI Elernents on PMI Representation Coverage worksheets
[ ] Process only Dimensions for the Semantic PMI Analysis report

[] Do not generate links to STEP files and spreadsheets on File Summary worksheet for Multiple files

Write Output to
(®) Same directory as the STEP file

(O User-defined directory: | C:/Users/lipman/Documents/Analyzer/trmp Browse

Figure 13: Spreadsheet tab

Section 5.5.1 shows how Maximum Rows can be used to limit the number of rows on any worksheet.

Formatting options:

e Section 5.5.2 describes processing text strings with symbols and non-English characters.

e Section 5.5.3 shows an example of generating tables for sorting and filtering.

e Section 5.5.4 shows an example of not rounding real numbers in spreadsheet cells.
Other options:

The Viewer generates an X3D file which can be saved and displayed in X3D viewers or
processed by other software (Sec. 4.5) [31].

Section 4.2.1 describes generating viewpoints for graphical PMI saved views.

Table 2 shows all PMI Elements that can appear on a PMI Representation Coverage worksheet.
For the semantic PMI analysis report, analyze only dimensional tolerances and no geometric
tolerances, datums, or datum targets.

Not generating links on the File Summary worksheet is useful when sharing spreadsheets.

Output files can be written to the same directory as the STEP file or to a user-defined directory.

14



4 Viewer

SFA can generate views for part geometry, graphical PMI annotations, AP242 tessellated part geometry,
and AP209 finite element models. The views are shown in the default web browser using X3DOM [32].
Internet Explorer is not supported. The resulting view file is named myfile-sfa.html. The HTML file is
self-contained and can be shared with other users, including those on non-Windows systems, although an
Internet connection is required. Viewer examples are available in the Examples menu.

The origin of the model at '0 0 0' is shown with a small colored XYZ coordinate axis that can be switched
off. The background color can be changed between white, blue, gray, and black.

In the view, use key 'a' to view all (+Y axis up) and 'r' to restore to the original view (+Z axis up).
Sometimes the model might be located far away from the origin. In this case, turn off the Origin and use
'a' to view all. The function of other keys is described in the link 'Use the mouse'. Navigation uses the
Examine Mode. Use PageDown to cycle between front, side, and top viewpoints. The last viewpoint in
the cycle is an orthographic projection. Section 4.2.1 describes viewpoints for graphical PMI saved views
that can be generated instead of most front, side, and top viewpoints.

4.1 Part Geometry

Figure 14 shows the part geometry view for a simple assembly. Part edges are shown in black.
Generating edges can be selected in the View section on the Options tab. If only part geometry needs to
be viewed, select Part Only in the Generate section on the Options tab.

There is a list of checkboxes for the parts and/or assemblies in the model. Most assemblies and parts can
be switched on and off depending on the assembly structure. The Show/Hide checkbox reverses the
checkboxes for the parts and/or assemblies. Some names in the list might have an underscore and number
appended to their name. Processing sketch geometry might also affect the list of names. Some
assemblies have no unique names assigned to parts, therefore there is no list of part names. Names that
use non-English characters might have different or missing characters. In this case, try to convert the
encoding of the STEP file to UTF-8 with the Notepad++ text editor? or other software (Sec. 5.5.2).

The bounding box min and max XYZ coordinates are based on the faceted geometry being shown and not
the exact geometry in the STEP file. There might be a variation in the coordinates depending on the
Quality option described below. The bounding box also accounts for any sketch geometry if it is
displayed, but not graphical PMI and supplemental geometry.

Nested assemblies are supported where one STEP file contains the assembly structure with external file
references to individual assembly components that contain part geometry.

Clicking on the model shows the part name (rod) in the upper left. A small dot might be visible where the
model was clicked. The part name shown may not be in the list of assemblies and parts on the right. The
part might be contained in a higher-level assembly that is in the list.

For very large STEP files, it might take several minutes to process the STEP part geometry. The resulting
HTML file also might several minutes to display in the web browser. Select 'Wait' if the web browser

prompts that it is running slowly when opening the HTML file.

The part geometry viewer is based on the STEP to X3D translator [1] and only runs on 64-bit computers.

2 https://notepad-plus-plus.org/
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asl-oc-214.stp AP214 2008-07-24T15:00

Part: rod

Part Geometry
Edges

Assembly/Part B Show/Hide
|-bracket-assembly

plate

rod-assembly

[CJ Part Bounding Box
Min: -10. 0. -4.
Max: 190. 150. 80.

Origin

Background Color
O White

®Blue

O Gray

O Black

Transparency
(approximate)

Page Down for Viewpoints. Key
'r" to restore, 'a' to view all. Use
the mouse in 'Examine Mode'
to rotate, pan, zoom.

Figure 15 shows the assembly with edges switched off with a white background.

Figure 14: Part geometry view

asl-oc-214.stp AP214 2008-07-24T15:00

Part: |-bracket

Part Geometry
[JEdges

Assembly/Part B Show/Hide
|-bracket-assembly

plate

rod-assembly

[JPart Bounding Box
Min: -10. 0. -4.
Max: 190. 150. 80.

B Origin

Background Color
® White

O Blue

O Gray

O Black

Transparency
(approximate)

Page Down for Viewpoints. Key
'r' to restore, 'a' to view all. Use
the mouse in 'Examine Mode"
to rotate, pan, zoom.

Figure 15: Part geometry view with edges switched off
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Figure 16 shows the assembly with the rod-assembly switched off with a gray background.

asl-oc-214.stp AP214 2008-07-24T15:00

Part: plate

Part Geometry
Edges

Assembly/Part B Show/Hide
|-bracket-assembly

plate

O rod-assembly

[CJ Part Bounding Box
Min: -10. 0. -4.
Max: 190. 150. 80.

Origin

Background Color
O White

O Blue

® Gray

O Black

| Transparency
(approximate)

Page Down for Viewpoints. Key
'r' to restore, 'a' to view all. Use
the mouse in 'Examine Mode'
to rotate, pan, zoom.

Figure 16: Part geometry view with rod-assembly switched off

Figure 17 shows using the Show/Hide checkbox to switch all parts on or off.

asl-oc-214.stp AP214 2008-07-24T15:00

Part: rod

Part Geometry
Edges

Assembly/Part [ Show/Hide
O |-bracket-assembly

O plate

rod-assembly

[CJ Part Bounding Box
Min: -10. 0. -4.
Max: 190. 150. 80.

Origin

Background Color
\< ® white

O Blue

O Gray

O Black

Transparency
(approximate)

Page Down for Viewpoints. Key
'r' to restore, 'a' to view all. Use
the mouse in 'Examine Mode"
to rotate, pan, zoom.

Figure 17: Part geometry view with bracket assembly and plate switched off
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Figure 18 shows the assembly partially transparent by using the transparency slider bar. Transparency is
only an approximation as shown by the missing three red nuts and the bottoms of the three blue bolts on
the right. This limitation might cause parts inside assemblies to be invisible. The approximation is due to
how transparency is implemented in X3DOM [32]. The bounding box is also shown.

asl-oc-214.stp AP214 2008-07-24T15:00

Part: rod

Part Geometry
EEdges

Assembly/Part B Show/Hide
I—hratket—assemh\y

plate

rud-assemb\v

E Part Bounding Box
Min: -10. 0. -4.
Max: 190. 150. 80.

B Origin

Background Color
® White

O Blue

O Gray

O Black

Transparency
(approximate)

Page Down for Viewpoints. Key
'r' to restore, 'a' to view all. Use
the mouse in 'Examine Mode"
to rotate, pan, zoom.

Figure 18: Part geometry view with approximate transparency

Figure 19 shows only part edges by making the assembly completely transparent.

asl-oc-214.stp AP214 2008-07-24T15:00

Part: rod

Part Geometry
EEdges

Assembly/Part B Show/Hide
|-bracket-assembly

platE

rod-assembly

CJPart Bounding Box
Min: -10. 0. -4,
Max: 190, 150. 80.

4 Origin

Background Color
® White

O Blue

O Gray

O lack

Transparency
(approximate)

Page Down for Viewpoints. Key
'r' to restore, 'a' to view all. Use
the mouse in 'Examine Mode'
to rotate, pan, zoom.

Figure 19: Part geometry view with edges only
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4.1.1 Part Quality and Normals

Three levels of part quality (low, normal, high) can be selected in the View section of the Options tab.
Quality controls the number of facets used for curved surfaces. For example, the higher the quality the
more facets used around the circumference of a cylinder. A part geometry view with low quality selected
is shown in Figure 20. The facets around the cylindrical surfaces are clearly visible. Although the part
geometry is always displayed by default with smooth shading, a discontinuity in the shading is also
apparent. Figure 21 shows the same part with quality set to high and normals selected. Normals improve
the smooth shading by explicitly computing surface normals and improves the appearance of curved
surfaces.

io1-tu-203.stp AP203

Part:

# Part Geometry
Part Bounding Box

Min: 0. -44. -44
-~ Max: 31. 44. 44,
! QOrigin
Background Color
‘\7—“___ White
® Blue
- Gray

Black

Transparency
(approximate)

Key 'a’ to view all, 'r to
restore, Page Up for
orthographic. Use the
mouse in "Examine
Mode' to rotate, pan,
Zoom

Figure 20: Part geometry view with low quality

io1-tu-203.stp AP203

Part:

# Part Geometry
Part Bounding Box
- Min: 0. -44. -44

Max: 31. 44, 44

# Origin
Background Color
\ White
\ ® Blue
o Gray
Black
Transparency
\ (approximate)

Key 'a' to view all, 'r' to
restore, Page Up for
orthographic. Use the
mouse in "Examine
Mode' to rotate, pan,
Zoom

Figure 21: Part geometry view with high quality and normals
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4.1.2 Sketch Geometry

The white lines in Figure 22 are an example of sketch geometry that is usually created in a CAD system
to aid in modeling geometry. The option for sketch geometry is in the View section of the Options tab.
Sketch geometry is not the same as supplemental geometry described below. The assembly? also has
eight different types of parts that can be switched on and off. See the Examples menu to view the
assembly*.

NIST_MTC_CRADA_ASSEMBLY_REV-D.STP AP242el 2018-04-23T12:23

Part: nist_mtc_crada_cover_rev-B-1

Part Geometry
Sketch Geometry
Edges

Assembly/Part &4 Show/Hide

S50591A141 ZINC PLATED STEEL HEX NUT-1 -
91374A118_COATED ALLOY STEEL SOCKET HEAD CAP
91274A141_COATED ALLOY STEEL SOCKET HEAD CAP .
91304A112_BLUE FLAT-HEAD SOCKET CAP SCREW-2
nist_mtc_crada_box_rev-D-1
nist_mtc_crada_cover_rev-8-1
nist_mtc_crada_plate_rev-A-1

nistimtcicladajulvcarbdwinduw—l -
(IS

I Part Bounding Box
Min: 0. 0. -57.998
Max: 152.4 101.6 279.79

Origin

Background Color
O White

@ Blue

O Gray

ol

Figure 22: Part geometry view with sketch geometry

3 https://www.nist.gov/el/systems-integration-division-73400/mbe-pmi-validation-and-conformance-
testing-project/download
4 https://pages.nist.2ov/CAD-PMI-Testing/step-file-viewer.html
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4.1.3 Supplemental Geometry

Figure 23 shows a part with supplemental geometry including planes, lines, and coordinate systems.
Supplemental geometry is shown only if part geometry or graphical PMI is also viewed. Supplemental
geometry is not associated with graphical PMI saved views. Supplemental geometry is not the same as
sketch geometry described above.

The following types of supplemental geometry and associated text are supported.

Coordinate System: red/green/blue axes
Plane: blue transparent outlined surface
Cylinder: blue transparent cylinder
Line/Circle/Ellipse: purple line/circle/ellipse
Point: black dot

Tessellated Surface: faces outlined in black

Colors defined in the STEP file override the default colors above. Unbounded planes are shown with a
square planar surface.

Supplemental geometry is also counted on the PMI Coverage Analysis worksheet (Sec. 6.1.7) if a View is
generated.

nist_ctc_02_asmel_rc_cr4050_ra.stp AP242el 2021-07-29T15:51

Part: NIST_CTC_02_ASME1_RC_CR4050_RA

MIST Test Case Drawing

Part Geometry
Edges

Supplemental Geometry

[CJ Part Bounding Box
Min: -340. -55.069 -360.
Max: 340. 838.98 40.

[J origin

Background Color
® White

OBlue

O Gray

O Black

Transparency
(approximate)

L )

Page Down for Viewpoints. Key
'r' to restore, 'a' to view all.
Use the mouse in 'Examine
Mode' to rotate, pan, zoom.

Figure 23: Part with supplemental geometry

21




4.2 Graphical PMI

Graphical PMI (PMI presentation) can be viewed by selecting the option in the View section of the
Options tab. STEP AP203, AP214, and AP242 support graphical PMI.

Figure 24 shows the graphical PMI that corresponds to the annotations shown in Figure 51. The view file

contains the line segments defined by the polylines in column F of Figure 72. In this example, each part
of the graphical PMI is assigned a different color to help differentiate them from each other.

There is a checkbox for the graphical PMI associated with saved view MBD_0. In this case, there is only

one saved view for the PMI.

nist_ctc_03_asmel_ap203.stp AP203 2017-03-30T09:24

The STEP file contains only Graphical PMI and no Semantic PMI.  Part: nist_ctc_03_asmel

L Y T - P 200 =01
SRS L& [6a6]o[a[c] L

MIST Test Case Drawing

Part Geometry
[ sketch Geometry
Edges

Supplemental Geometry

Saved View Graphical PMI
MBD_0

[ Part Bounding Box
Min: -330.2 -45.72 0.
Max: 88.9 504.49 162.68

[ Origin

Transparency
(approximate)

Page Down for Viewpoints.

Figure 24: Graphical PMI
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4.2.1 Saved Views

A saved view is a subset of all graphical PMI. Multiple saved views will have multiple checkboxes as
shown in Figure 25. In this example the graphical PMI in each of the three saved views is assigned a
different color.

sp7_06-c3e-242e2.stp AP242e2 2021-09-06T16:43

Some Graphical PMI might not have equivalent Semantic PMI in the STEP file. Part: NIST PMI FTC 06 ASME1

=T TeoTe T GEF TAITION. NIST Test Case Drawing
\L¥-TOLERAKGED DIMENSIONS anp
e - BASTC
o y
o G o, PN T - (o oot
THENST A

BY THE WODEL. gsTafy 4 Eﬂﬂ — Sketch Geometr
: EL. LL OTH < v
(oL DATA FROI THE NODEL, Tie i @ Edges

E .EA T8 BASIC DINENSTONAL DATA b g
ERIISE SPECIFIED, §

STANDARDS an S ¥

-2003 APPL ]}

Supplemental Geometry

Saved View Graphical PMI

{Use Page Down to switch between
Saved Views. Viewpoints might not be
implemented correctly.}

MBD_A

MBD_B

MBD_C

[ Part Bounding Box
Min: -152.4 0. -247.65
Max: 152.4 97.79 0.

[ Origin

Background Color
. ® White

® O Blue

O Gray

o8 O Black

Figure 25: Graphical PMI with multiple saved views

A viewpoint position and orientation can also be associated with a saved view. Saved view viewpoints
can be included in the view instead of front, side, and top viewpoints. Using PageDown in the viewer to
cycle through the saved views, switches to the associated viewpoint and subset of graphical PMI. Figure
26 shows the saved views for MBD_A, MBD_B, and MBD_C. The saved views correspond to what is
shown in the link to the NIST Test Case Drawing. Sometimes some graphical PMI is not in a saved view
and will be labeled ‘Not In a Saved View’ in the list of saved views.

Saved view viewpoints might not be implemented correctly in older versions of software that exports

STEP AP242 files. The option on the Spreadsheet tab in the Other section will display the geometry of
the view frustrum for a saved view viewpoint.
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sp7_06-c3e-242e2.stp AP242e2 2021-09-06T16:43

Some Graphical PMI might not have equivalent Semantic PMI in the STEP file. Part: NIST PMI FTC 06 ASME1

WOTES (UNLESS OTHERWISE SPECIFIER):

CAD VODEL REV. __ IS REQUIRER
TO COMPLETE PRODUCT DEFINITION.

DIRECTLY-TOLERANCED DIMENSLONS AND BASIC
DIMENSIONS DEFINED ON THE DRAKING TAKE
PRECEDENCE OVER DIMENSIONAL DATA
DEFINEC BY THE WODEL. OBTAIN ALL OTHER

DIMENSIONAL DATA FROM THE WOOEL. THE fay
MODEL REPRESENTS BASIC DIWENSTONAL DATA S99 |
UNLESS OTHERWISE SPECIFIED

APPLIGABLE STANDARDS: .
ASUE Y14,41-2003 APPLIES TO DATASET, 1k3

ASHE 14,54-1994 APPLIES TO DIMENSIONIKG *
AND TOLERANCING

APPLIES TO ALL 08
30

1. [ 05]4]
UNTOLERANCED SURFACES

UNITS: IHCHES

NIST Test Case Drawing

Part Geometry
Sketch Geometry
Edges

Supplemental Geometry

Saved View Graphical PMI

{Use Page Down to switch between
Saved Views. Viewpoints might not be
implemented correctly)

MBD_A

CIMBD_B

COmBD_C

[ Part Bounding Box
Min: -152.4 0. -247.65
Max: 152.4 97.79 0.

[ Origin

Background Color
® White

OBlue

O Gray

O Black

sp7_06-c3e-242e2.stp AP242e2 2021-09-06T16:43

Some Graphical PMI might not have equivalent Semantic PMI in the STEP file. Part: NIST PMI FTC 06 ASME1

NIST Test Case Drawing

Part Geometry
Sketch Geometry
Edges

Supplemental Geometry

Saved View Graphical PMI

{Use Page Down ta switch between
Saved Views. Viewpeints might not be
implemented correctly )

[CImBD_A

MBD_B

Cmep_c

[CIPart Bounding Box
Mis 152.4 0. -247.65
Max: 152.4 97.79 0.

O origin

Background Color
® White

O Blue

O Gray

O Black

sp7_06-c3e-242e2.stp AP242e2 2021-09-06T16:43

Some Graphical PMI might not have equivalent Semantic PMI in the STEP file. Part: NIST PMI FTC 06 ASME1

50+.008

z . 2
[&[@. ors]o]c]

; F1.000 )

NIST Test Case Drawing

Part Geometry
Sketch Geometry
Edges

Supplemental Geometry

Saved View Graphical PMI

{Use Page Down to switch between
Saved Views. Viewpeints might not be
implemented correctly )

[CImBD_A

[JmBD_B

MBD_C

[J Part Bounding Box
Min: -152.4 0. -247.65
Max: 152.4 97.79 0.

Clorigin

Background Color
® White

O Blue

O Gray

O Black

Figure 26: Graphical PMI with multiple saved view viewpoints
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4.2.2 Datum Targets

Datum targets are shown only if a spreadsheet is generated with the analysis for semantic PMI selected
and when part geometry or graphical PMI is also viewed. Figure 27 shows an example of a part with a
rectangular datum target highlighted in red. The graphical PMI also has a datum target symbol, C1 in the
circle, pointing to the datum target.

There are two methods to represent and view the position, orientation, and dimensions of a datum target
in a STEP file. For the first method, the position, orientation, and target length, width, and diameter are
specified parametrically. Point, line, circle, circular curve, and rectangle datum targets are supported. A
small coordinate axes is shown at the origin of a datum target except for point datum targets in addition to
the datum target label.

For the second method, the shape and location of arbitrarily shaped area and curve datum targets is
specified with geometric entities. Supported geometric entities, that lie in plane, are line, circle, trimmed
curves, and faces bounded by lines, circles, or ellipses. If other geometric entities are used, then either the
datum target will not be shown or some of the edges of the datum targets will be missing. Datum targets
defined by multiple types of curves and non-planar datum targets are not supported.

Both types of datum targets are shown in red and can be switched on and off in the view. Datum target
feature geometry, also specified with geometric entities similar to the second method, is shown in green.

nist_ctc_05_asmel_ap242-el.stp AP242el 2020-01-24T11:03

Some Graphical PMI might not have equivalent Semantic PMI in the STEP file. Part: nist_ctc_05_asmel

i @] = NIST Test Case Drawing
{
e / Part Geometry
| Edges
O ‘I.‘II Datum Targets
fll Saved View Graphical PMI

{Use Page Down to switch between

Saved Views. Viewpoints might not be

implemented correctly.}
MBD_A
[JMBD B

[ Part Bounding Box
Min: -263.52 -279.4 0.
Max: 263.52 279.4 482.6

[ Origin

Background Color
@ White

O Blue

O Gray

O Black

Transparency
(approximate)

Figure 27: Graphical PMI with a datum target
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4.2.3 Holes
Hole features, including basic round, counterbore, and countersink holes, and spotface are supported in

AP242 edition 2 but have not been widely implemented. If the semantic PMI analysis report is not
generated, then holes are shown only with a drill entry point.

If the report is generated, then cylindrical or conical surfaces are used to view the depth and diameter of
the hole, counterbore, and countersink. If there is no depth associated with the hole (a through hole), then
a very thin cylindrical surface with the correct diameter is shown. The bottom of a hole is also shown if
the hole is not a through hole and the hole has a depth. Usually, only the counterbore or countersink is
shown for through holes. Semantic information related to holes is reported on *_hole_definition and
basic_round_hole worksheets.

Holes can be switched on and off in the viewer. Cylindrical surfaces are green and conical surfaces are
blue. Holes are viewed regardless of whether or not they were explicitly modeled in the part geometry.

4.3 AP242 Tessellated Part Geometry

Tessellated part geometry can be viewed by selecting the option in the View section of the Options tab.
STEP AP242 supports tessellated part geometry, but not AP203 and AP214. It is typically written to a
STEP file instead of or in addition to b-rep part geometry (Sec. 4.1). Figure 28 shows tessellated part
geometry where each tessellated facet is outlined. Individual parts can be switched on and off. Parts in
an assembly might be in the wrong position and orientation or be missing.

ts1_3de.stp AP242el 2014-08-18T13:55

Part: xVOL2

Tessellated Part Geometry

Tessellated Parts in an assembly
might be in the wrong position and

orientation or be missing.

Tessellated Parts
¥WOLL

AOLLOD

AWoLz

¥WOLS

WWOLE

WOLT

WOLE

WOLS

B Origin

Background Color
O White

® Blue

O Gray

O Black

Transparency
(approximate)

Figure 28: AP242 tessellated part geometry
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4.4 AP209 Finite Element Model

The finite element model in a STEP AP209 file can be viewed by selecting the option in the View section
of the Options tab. Nodes, 1D elements, 2D elements, and 3D elements are shown along with the finite
element mesh. Viewing boundary conditions, loads, and displacements is also supported. Multiple
coordinate systems and viewing of stresses and strains is not supported. There might be insufficient
memory for SFA to process very large finite element models.

4.4.1 Finite Element Mesh

Figure 29 shows the view of the finite element model (FEM) of an ultra-lightweight glider [9]. 2D
elements are cyan, 1D elements are magenta, nodes are blue, and the mesh is black. To the right of the
view are checkboxes for Nodes, Mesh, and 1D and 2D Elements. The number of nodes and different
element types are also listed.

ULGv2_AP209ed1.stp AP209e1

Nodes
< Mesh
< 1D Elements
¥ 2D Elements

« 13186 - nodes

« 1-dummy node

s 1720 - curve_linear
« 14300 - quad_linear
o 442 _fria_linear

¥ Qrigin

Background Color
® White
Blue
Gray
Black

o'io}';'::’ Transparency

%,
(A
eat
s
s
5

e

s

(approximate)

Key 'a' to view all, 'r' to
restore, Page Up for
orthographic. Use the mouse
in 'Examine Mode' to rotate,
pan, zoom

Figure 29: AP209 FEM of ultra-lightweight glider
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Figure 30 shows the same FEM without the mesh where the magenta-colored 1D elements are visible

because the 2D elements are partially transparent.

ULGv2_AP209ed1.stp AP20%e1

Nodes

Mesh
< 1D Elements
< 2D Elements

+ 13186 - nodes

« 1-dummy node

« 1720 - curve_linear
« 14300 - quad_linear
« 442 _tria_linear

# Origin

Background Color
© White
Blue
Gray
Black

Transparency
(approximate)

Key 'a' to view all, 'r' to
restore, Page Up for
orthographic. Use the mouse
in 'Examine Mode' to rotate,
pan, zoom

Figure 30: AP209 FEM, no mesh

Figure 31 shows only the nodes of the same FEM.

ULGv2_AP209%ed1.stp AP209e1

¥ Nodes
Mesh
1D Elements
2D Elements

13186 - nodes

1 - dummy node
1720 - curve_linear
14300 - quad_linear
447 - tria_linear

# Qrigin

Background Color
® White

Blue

Gray

Black

Transparency
(approximate)

Key 'a' to view all, 'r' to
restore, Page Up for
orthographic. Use the mouse
in 'Examine Mode' to rotate,
pan, zeom.

Figure 31: AP209 FEM, nodes only
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4.4.2 Boundary Conditions, Loads, and Displacements
Figure 32 shows the AP209 FEM that is used to show boundary conditions, loads, and displacements.
Options to control how they are viewed are on the Options tab.
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“/Mesh
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Boundary Conditions
spct.1
Scale

Loads
force.1

0.062 4537 9.013
Scale

Displacements
Default

0 5.31e-3 0.011
Scale

« 615 - nodes
« 1 - dummy node
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Gray

Black

Transparency
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Key 'a' to view all, 'r' to

restore, Page Up for

orthographic. Use the mouse
= Lade' in catal

Figure 32: AP209 FEM

Table 1 shows the icons used for constrained degrees-of-freedom (DOF). Different types of icons can be
combined for the appropriate DOF.

Table 1: Icons for constrained DOF

Degree-of-freedom Icon

All six DOF Gray box

All three translation DOF Gray pyramid

All three rotation DOF Gray sphere

Single translation DOF Red (x), green (y), or blue (z)

line along the constrained
translation DOF axis

Single rotation DOF Red (x), green (y), or blue (z)
circle around the constrained
rotation DOF axis
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Figure 33 shows some of the nodal boundary conditions for the FEM in Figure 32. All rotation (gray
spheres) and Z translation (blue vertical lines) DOF are constrained for all nodes. Nodes along the X and
Y axis are constrained in Y (green lines) and X (red lines) DOF, respectively.
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Figure 33: AP209 nodal boundary conditions

Figure 34 shows nodal load vectors that are colored and scaled by the magnitude of the load. The vectors
can also be shown with constant length. In this example there is only one load case. The color scale
shows the value of the loads.
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Figure 34: AP209 nodal load vectors
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Figure 35 shows nodal displacement vectors that are colored and scaled by the magnitude of the
displacement. The color scale shows the value of the displacements. The finite element mesh is not
displaced.
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Figure 35: AP209 displacement vectors

Figure 36 shows the displacements for one of ten mode shapes of a connecting rod.
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Figure 36: AP209 mode shape displacements
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4.5 Augmented Reality

The viewer can save an X3D file [33] with the option on the Spreadsheet tab. Figure 37 shows an
augmented reality application® to visualize model-based product definitions that uses the saved X3D file
[31].

Figure 37: Augmented reality application of SFA output

5 https://pages.nist.gov/CAD-PMI-Testing/NIST-AR-video.html
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5 Spreadsheets

Typical STEP file viewers show a 3D view of the part or model represented by the STEP file. The
viewers usually have a high-level hierarchical display of the assembly structure in the STEP file where
you can drill down to individual attributes of parts. However, there is no way to view all of the actual
STEP entities and their attributes at once.

SFA provides this capability by creating a spreadsheet from the STEP file. The spreadsheet generated by
SFA contains several worksheets. There are Summary and Header worksheets, along with a worksheet
for each entity type that was processed from the STEP file. Links to sample worksheets are in the
Examples menu.

5.1 Summary Worksheet

A Summary worksheet is shown in Figure 38. Rows 1-7 contain basic information about the STEP file
including a link to documentation for the schema used in the file. Starting with row 10, each row in
column A is the name of an entity processed from the STEP file. The entity names are linked to their
corresponding worksheet. Column B is the number of each entity type.

A B C D

1 |STEP Directory C:\Users\lipmanDocuments\A
2 |STEP File Vertical-Plate.stp
3 |Excel File Vertical-Plate-sfa.xlsx
4 | Application Autodesk Inventor 2011
5 |Timestamp 2011-10-07T13:05:48
& |Total Entities "84
7 |Schema AP214
8
9 Entity Count
10 1
1 1
12 1
13 1
14 1
15 1
16 1
17 1
18 ................. 1

2
19
20 1
21 1
22 1
23 1
24 1
25 1
26 1
27 1
28 1
29 1
30 1
31 1
32 1
33 58
34 99

_ draughting_pre_defined_colour __fill area_style

Figure 38: Summary worksheet
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At the bottom of the spreadsheet are tabs for the Summary, Header, and many entity worksheets. Entities
in column A and in the worksheet, tabs are grouped, ordered, and colored according to the categories of
entities in the Process section of the Options tab. Selecting a tab, using the links in column A, or using
the Control-PageUp and Control-PageDown keys will switch to a different worksheet.

5.2 Header Worksheet

A Header worksheet is shown in Figure 39. Rows 3-11 contain the information in a STEP file header
section. Rows 1 and 2 are the STEP file name and directory.

A E

1 Mame Vertical Plate
2 |FileDirectory ChUsers\lipman\Documents\CAx-IF\STEP Files\,
3 |FileDescription
4 |FilelmplementationLevel 2;1
5 |FileTimeStamp 2011-10-07T13:05:48
6 |FileAuthor lipman
7 |FileOrganization
& |FilePreprocessorVersion Autodesk Inventor 2011
8 |FileOriginatingSystem Autodesk Inventor 2011
10 |FileAuthorisation
11 |SchemaMame AUTOMOTIVE DESIGM {10103032141111}

3 summary Header draughting_pre_defined_colour fill_a

Figure 39: Header worksheet

5.3 Entity Worksheets

An entity worksheet is generated for each entity type shown on the Summary worksheet above. The
following example relates entities in a STEP file to the resulting worksheet generated by SFA. Six
datum_system entities from a STEP file are shown in Figure 40. The entity ID is the number before the
equal sign. Values between the outermost parentheses are attribute values that are separated by commas.
There are several different types of attributes including strings delimited by quote marks, references to
other entity IDs (numbers preceded by #), boolean values (.T.), and null values ($).

#37106=DATUM_SYSTEM( 'Perpendicularity.1',$,#56,.T., (#37101));

#42046=DATUM_SYSTEM( 'Position.1',$,#56,.T., (#42036,#42041));

#51481=DATUM_SYSTEM( 'Position.3",$,#56,.T., (#51466,#51471,%51476));
#53696=DATUM_SYSTEM( 'Position.4",$,#56,.T., (#53681,#53686,%53691));
#70801=DATUM_SYSTEM( 'Position Surfacic Profile.2',$,#56,.T., (#70786,#70791,#70796));
#84091=DATUM_SYSTEM( 'Perpendicularity.2',$,#56,.T., (#84086));

Figure 40: datum_system entities
The resulting datum_system entity worksheet is shown in Figure 41. Row 1 contains the name of the

entity and the number of entities. It is also a link back to the Summary worksheet. Row 3 is the names of
the entity attributes. Column A is the entity ID.
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Starting with row 4, each row contains the attribute values for an entity. Column B is the text string for
the name attribute. Column C is the description attribute which is blank as indicated by the dollar sign
above. Column D is the of_shape attribute where, in this example, all of the values for the entities are
product_definition_shape 56. This means that the of_shape attribute is a reference to the
product_definition_shape entity with an ID of 56 as shown above. In column F, the constituents
attribute refers to either single or multiple datum_reference_compartment entities. The number in
parentheses is the number of entity references and the numbers after the entity name are the entity IDs
that are referenced.

A B C D E F
1 datum system (6)
2
1D name description of_shape product_definitional constituents
3
37106 |Perpendicularity.1 product_definition_shape 56 TRUE (1) datum_reference_compartment 37101
4
42046|Position.1 product_definition_shape 56 TRUE (2) datum_reference_compartment 42036 42041
5
51481|Position.3 product_definition_shape 56 TRUE (3) datum_reference_compartment 51466 51471 51476
6
53696|Position.4 product_definition_shape 56 TRUE (3) datum_reference_compartment 53681 53686 53691
7
70801 |Position Surfacic Profile.2 product_definition_shape 56 TRUE (3) datum_reference_compartment 70786 70791 70796
8
9 | 84091|Perpendicularity.2 product_definition_shape 56 TRUE (1) datum_reference compartment 84086

Figure 41: Entity worksheet (datum_system)

In the draughting_model entity worksheet, shown in Figure 42, cells C4 and C6 refer to multiple entity
types. Cell C5 refers to multiple styled_item entities, however, the entity IDs are not shown because
there are too many entity IDs to fit in one worksheet cell.

A B C
1 | draughting model (3)
2
3 1D name items
4 31471 (2) annotation_plane 29651 31466 (1) axis2_placement_3d 36
5 | 31941 (93) styled_item
5]

32031 detail view (1) axis2_placement_3d 36 (1) camera_model_d3_multi_clipping 32026

Figure 42: Entity worksheet (draughting model)
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5.4 Skipped Attributes

Sometimes SFA skips some specific types of entity attributes due to limitations of the IFCsvr toolkit. A
message about skipping an entity attribute will be shown in the Status tab and question marks are shown
in the worksheet. Figure 43 shows question marks (???) in column E where the control_points_list
attributes were skipped.

A B C D E
1 b spling surface with knots (730)
2
3 ID |name u_degree v_degree control_points_list
4 51332 5 5?7
5 51464 3 1797

Figure 43: Entity worksheet (b_spline_surface_with_knots)

5.5 Options

There are several options that affect how information is shown in a spreadsheet.

5.5.1 Maximum Rows

The maximum rows option in the Spreadsheet tab limits the maximum numbers of rows in any
spreadsheet or CSV file to the selected value. This reduces the size of the spreadsheet and speed
processing of the STEP file. Figure 44 shows that only the first 100 of 43681 rows for the
cartesian_point entities are written to the worksheet. Syntax errors (Sec.6.5) related to reports might be
missed if some entities are not processed due smaller values for maximum rows.

A B C
1 cartesian point (100 of 43681)
2
3 ID [name coordinates
4 18|#18 -0.9881 1.634176638 18.017717023
5 20(#20 -0.9881 1.547763978 17.548888756
5] 22(#22  -0.892674976425 1.568442637 17.469469568
7 24(#24 -0.247174976425 1.828113272 17.582158424
8 26|#26 -0.1846 1.864882875 17.656001817
9 28|#28 -0.1846 1.961858223 18.18213751
10 30|#30 0.3089 2.140780414 18.161940186

Figure 44: Maximum rows example

5.5.2 Text Strings and Numbers

Text strings in STEP files might use non-English characters or symbols. Some examples are accented
characters in European languages (for example ¢), and Asian languages that use different characters sets
such as Cyrillic or Chinese. Text strings with non-English characters or symbols are usually found on
descriptive measure or product related STEP entities with name, description, or id attributes.
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According to ISO 10303 Part 21 section 6.4.3 [5], Unicode can be used for non-English characters and
symbols with the control directives \X\ and \X2\. For example, \X\E9 or \X2\00E9\XO\ is used for the
accented character é. Unicode characters, such as E9, are defined by the Unicode standard®. Some CAD
software does not support these control directives when exporting or importing a STEP file.

For a spreadsheet, the \X\ and \S\ control directives are supported by default. Use the option on the
Spreadsheets tab to support non-English characters using the \X2\ control directive. In some cases, the
option will be automatically selected based on the file schema or size. There is a warning message if \X2\
is detected in the STEP file and the option is not selected. In this case the \X2\ characters are ignored and
will be missing in the spreadsheet. Figure 45 shows an example of how Unicode text strings appear in the
spreadsheet.

A B C
string wiith language (140}

2
3 1D contents language specification
46 583 |CoroPlex™ MT myATHQYHHUMOHANEH MHCTPYMEHT 33 Qpe30BaHe U CTpyroeaHe language 606
47 584 Multifunkéni nastroj CoroPlex™ MT pro frézovani a soustruZeni language 607
48 585|CoroPlex™ MT multifunktionsvaerkiej til freesning og drejning language 608
48 586|CoraPlex™ MT Multifunktionales Dreh- und Fraswerkzeug language 609
50 587|CoraPlex™ MT multifunctional tool for milling and turning language 610
51 588|CoroPlex™ MT -monitoimitydkalu jyrsintdadn ja sorvaukseen language 611
52 589|0util multifonctions CoroPlex™ MT pour le fraisage et le tournage language 612
33 590|CoraPlex™ MT tobbfunkcids marg- és esztergaszerszam language 613
54 591|Utensile multifunzionale CoraPlex™ MT per tornitura e fresatura language 614
55 592/ 30 F L PAMT F54 20T - IEHIMTHESMETE language 615
36 593/ 22 9! A HE2 coroplex™ MT CH |5 & language 616
57 594|CoroPlex™ MT multifunctioneel gereedschap voor frezen en draaien language 617
38 595|CoraPlex™ MT, wielofunkcyjne narzedzie frezarskie i tokarskie language 618
39 596|Ferramenta multifuncional CoroPlex™ MT para torneamento e fresamento language 619
60 597|5culad multifunctionald CoroPlex™ MT pentru frezare si strunjire language 620
61 598 | MHOTOQYHHLMOHANBHBIA MHCTPYMEHT AnA dpe3epoeaHma M ToueHmAa CoroPlex™ MT  language 621
62 599|CoraPlex™ MT, herramienta multifuncional para fresado y torneado language 622
&3 600| CoroPlex™ MT flerfunktionsverktyg for frasning och svarvning language 623
64 601 tesasiiadadWaritiu CoroPlex™ MT dmfunisiaLazansnas language 624
65 602 | CoroPlex™ MT cok fonksiyonlu frezeleme ve tornalama takimi language 625
66 603 | BaraTodyHHLIOHANBHWMIA IHCTPYMEHT gnA $ppe3lepyeaHHA Ta TouiHHA CoroPlex™ MT language 626
67 604|CoroPlex™ MT% ThEE HHIFIZEHIJIE language 627

Figure 45: Entity worksheet with Unicode characters
For the viewer, all control directives are supported for part and assembly names.

Non-English characters that do not use the Unicode control directives are supported depending the STEP
file encoding, e.g., UTF-8 or ANSI. Use the Notepad++ text editor to convert the file to UTF-8 encoding.
Some non-English characters might cause the software to crash or prevent a view from being generated.
The Syntax Checker (Sec. 7) identifies non-English characters as 'illegal characters'.

Numbers in a STEP file use a period '.' as the decimal separator. Some non-English language versions of
Excel use a comma ', as a decimal separator. This might cause some real numbers to be formatted as a
date in a spreadsheet. For example, the number 1.5 might appear as 1-Mai.

¢ https://www.unicode.org/charts
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To change the formatting in Excel, go to the Excel File menu > Options > Advanced. Uncheck 'Use
system separators' and change 'Decimal separator' to a period . and 'Thousands separator' to a comma ,
Note that this change applies to all Excel spreadsheets on your computer. Change the separators back to
their original values when finished. You can always check the STEP file to see the actual value of the
number

5.5.3 Tables

Figure 46 shows the shape_aspect worksheet with the option for generating tables selected. With this
option, pull-down menus (selector on the right of each cell in row 3) are shown with the column headers
in row 3 that access functions to sort and filter the rows. The table is sorted by the name attribute in
column B. This is evident by the non-numerical ordering of the entity IDs in column A. The worksheet
containing validation properties (Sec. 6.3) is always sorted.

A B £ D E
1 shape|aspect (69}
2
ERLA name -1| descriptio of_shape v | product_definitiong ~
73686 Angularity.1 product_definition_shape 56 TRUE
4
73091|Flatness.1 product_definition_shape 56 TRUE
5
6 | 35771|Linear Size.1 product_definition_shape 56 TRUE
7 | 35736|Linear Size.1 product_definition_shape 56 TRUE
8 66951|Linear Size.10 product_definition_shape 56 TRUE
S | 66966|Linear Size.10 product_definition_shape 56 TRUE
10 69381|Linear Size.11 product_definition_shape 56 TRUE
89396 |Linear Size.11 product_definition_shape 56 TRUE
11
12 40141|Linear Size.2 product_definition_shape 56 TRUE

Figure 46: Entity worksheet (shape_aspect) with tables for sorting

5.5.4 Number Format

By default, when a single real number is written to a worksheet cell, Excel might round the number.
Figure 47, on the left, shows values of radius in column D that are rounded. Using the Number Format
option in the Spreadsheet tab to not round real numbers, results in the radius column is shown with full
precision in the worksheet on the right. The non-rounded real numbers are the actual values that appear
in a STEP file. The non-rounded real numbers are indicated by the small green triangle in the upper left
corner of a cell. The non-rounded real numbers are also left justified as opposed to the rounded real
numbers that are right justified. Real numbers that appear in pairs or triplets, such as cartesian points, are
never rounded.

A B C D A B C D
1 circle {146) 1 circle {146)
2 2
3 ID |nhame position radius 3 ID |[name position radius
4 86 axis2_placement_3d 85 3 4 86 axis2_placement_3d 85 ".999999999999695
5 103 axis2_placement_3d 102 3 5 103 axis2_placement_3d 102 "2.999999959999695
6 128 axis2_placement_3d 127 3 6 128 axis2_placement_3d 127 ".999999999999792
7 145 axis2_placement_3d 144 3 7 145 axis2_placement_3d 144 "2.999999999999792
8 170 axis2_placement_3d 169 3 8 170 axis2_placement_3d 169 ".999999999999695
9 187 axis2_placement_3d 186 3 9 187 axis2_placement_3d 186 "2.999999999999695
10 212 axis2_placement_3d 211 3 ||| 10 212 axis2_placement_3d 211 ".999999999999803
11 229 axis2_placement_3d 228 3| 11 229 axis2_placement_3d 228 ".999999999999803
12 358 axis2_placement_3d 357 3.375 ||| 12 358 axis2_placement_3d 357 3.375
13 388 axis2_placement_3d 387 3.375 ||| 13 388 axis2_placement_3d 387 3.375

Figure 47: Rounding numbers example
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5.6 Anchor Section

ISO 10303 Part 21 Edition 3 [27] is a new version of Part 21 that supports anchor, reference, and
signature sections in a STEP file. The anchor section can be used to assign a globally unique ID (GUID)
to a specific entity. Figure 48 shows the ANCHOR section in a STEP file which appears after the HEADER
section and before the DATA section.

ANCHOR;

<6dbd6831-4fab-4838-824b-91cead3922ed>=#18; /* product_definition */
<3c9773de-5015-4cB5-86bd-Be35a5bfdo6f>=#17876; /* dimensional_size */
<385dcdd8-dbcd-4edd-89c7-9ad5476774cb>=#17890; /* cylindricity_tolerance */
<B9cB7753-38cf-4928-928f-4acdBeb36247>=#17895; /* datum */
<flab2591-7el18-4898-90cd-abBff7916774>=#17899; /* datum */

<9416b6d8 -edef-4fBe-8b58-44d24aa5dBbe>=#17103; /* perpendicularity tolerance */
<2871dBc8-9f87-4349-3abB-7832e53Ta25a>=#17185; /* datum */

ENDSEC;

Figure 48: ANCHOR section in a STEP file

Figure 49 shows the ANCHOR section worksheet corresponding to the STEP file above.

A B

ANCHOR Y Entity
2 |<6db46031-4fab-4838-824b-91cead3g22e4==#10; /* product_definition */ product_definition
3 |<3c9773de-5015-4005-86b4-0e35a5bfdI6f>=#17076; /* dimensional_size */ dimensional_size
4 |<305dc4ds-d6cd-4edd-89c7-9ad5476774ch==#17090; /* cylindricity_tolerance */ cylindricity_tolerance
5 |=09c07753-38cf-4928-928f-dacdDef36247==#17095; /* datum */ datum
6 |<flab2591-7e18-4898-90c4-a60ff7916774>=#17099; /* datum */ datum
7 |<9416b6d8-edef-4f0e-8b50-44d24aa5d06e>=#17103; /* perpendicularity_tolerance */  perpendicularity_tolerance
8 |<2871d0cB-9f87-4349-aab0-7832e53fa25a>=#17105; /* datum */ datum

3 Summary Header | ANCHOR application_context id_attribute product product_context

Figure 49: ANCHOR section worksheet

Figure 50 shows the ANCHOR IDs associated with the three datum entities. ANCHOR IDs are also
reported on the PMI Representation Summary worksheet (Sec. 6.1.6). GUIDs can also be assigned to
entities with the id_attribute entity.

A B C D E F G
1 |datum (3)
2
3| ID name description of_shape product_definitional identification ANCHOR ID M
4 |17095|Simple Datum.1 product_definition_shape 11 FALSE A 09c07753-38cf-4928-928f-4acd0e636247
5 | 17099 Simple Datum.2 product_definition_shape 11 FALSE B f1ab2591-7e18-4898-90c4-ab0ff 7916774
6 |17105|Simple Datum.3 product_definition_shape 11 FALSE C 2871d0c8-9f87-4345-3ab0-7832e53fa25a

Figure 50: ANCHOR ID reported on datum worksheet
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6  Analysis Reports

The analysis reports check the STEP file against recommended practices are defined by the CAx
Interoperability Forum (CAx-IF) [26, 28]. The objective of the CAx-IF is to advance CAx (mainly
Computer-Aided Design, Engineering, and Manufacturing) software system translator development and
to ensure that user requirements for interoperability are satisfied. Three different reports can be created.

1. PMI Representation (Semantic PMI) described in Sec. 6.1
2. PMI Presentation (Graphical PMI) described in Sec. 6.2
3. Validation Properties described in Sec. 6.3

Product and manufacturing information (PMI) are annotations and attributes that define product geometry
and product specifications [34]. PMI includes 3D annotations to specify Geometric Dimensioning and
Tolerancing (GD&T), as well as non-geometric data such as surface texture specifications, finish
requirements, process notes, material specifications, and welding symbols. GD&T is a symbolic
language used to communicate tolerances on manufactured parts. The industry standards for presentation
of GD&T in axonometric views in 3D space are ASME Y14.41-2003 [35] and ISO 16792:2006 [36].
Some common tolerances include dimensional tolerances on length and diameter, and geometric
tolerances on flatness, position, surface profile, and circular runout.

Figure 51 shows NIST test case CTC 37 with typical feature control frames (FCF) with PMI annotations
including dimensions, geometric and dimensional tolerances, and datum features. Most of these types of
annotations are processed by SFA.

7 https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist ctc_03_asmel rc.pdf
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Figure 51: NIST test case CTC 3

Figure 52 shows the summary worksheet, similar to Figure 38, with entities highlighted that have
information related to PMI Representation and PMI Presentation. Rows 11-14 are entities related to the
datum reference frame. Row 15 is the dimensional_characteristic_representation entity which is
associated with all dimensional tolerances. Rows 10 and 19-29 are entities related to geometric
tolerances. Row 30 is the annotation_curve_occurrence entity which is associated with PMI
presentation. The entity name in parentheses in cell Al19 is for a complex entity
(flatness_tolerance)(geometric_tolerance_with_defined_unit_area). The cells colored gray indicate that
there are errors or warnings associated with at least one entity instance of the entity type. All of the
worksheets for the highlighted entities will have additional columns with PMI information related to that
type of entity.
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A B C D E F
STEP Directory C:\Users\lipman\Documents\Analyzer\User Gui
2 |STEP File nist ctc 03 asmel ap242.stp
3 | Excel File nist_ctc 03_asmel ap242-sfa.xlsx
4 Timestamp 2014-12-19T716:21:44+01:00
5 Total Entities 17312
& Schema AP242e1
7 Dimension Units IMCH
a
Entity Count
10 angularity tolerance [PMI Representation] 1
1 datum )
12 datum feature [PMI Representation] 6
13 datum reference compartment [PMI Representation] h 26
14 datum system [PMI Representation] h 6
15 dimensional characteristic representation [PMI Representation] h 10
16 dimensional location
17 dimensional size
18 directed dimensional location 1
(flatness tolerance)
[geometric tolerance with defined area unit) [PMI 1
1% Representation]
(geometric_tolerance with datum reference)
[geometric tolerance with modifiers) 2
20 [position tolerance) [PMI Representation]
{geometric_tolerance with datum reference) a
27| _(position tolerance) [PMI Representation]
[geometric tolerance with datum reference) 5
22 (surface profile tolerance) [PMI Representation]
23 perpendicularity tolerance [PMI Representation] 2
24 plus minus tolerance 8
25 shape dimension representation 10
26 surface profile tolerance [PMI Representation]
27 tolerance value
28 tolerance zone
249 [tolerance zone form
30 annotation curve occurrence [PMI Presentation] 30
3 Summary | Header PMI Representation Summary PMI Representation Coverage angularity_tg

Figure 52: Summary worksheet with entities highlighted for PMI

6.1 PMI Representation (Semantic PMI)

PMI representation (also known as semantic PMI) includes all information necessary to represent GD&T
without any graphical presentation elements. PMI representation is associated with CAD model geometry
and is computer-interpretable to facilitate automated consumption by downstream applications for
manufacturing, measurement, inspection, and others. PMI representation does not contain any
information regarding its visual appearance although an importing CAD system can attempt to recreate
the visual presentation of the annotation. The CAx-IF defines recommended practices for PMI
representation [37]. Syntax errors related to nonconformance to the recommended practices are
highlighted in red in the Status tab and in the relevant entity worksheets (Sec. 6.5).
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6.1.1 Visual Presentation of PMI Representation

Sections 6.1.2 through 6.1.4 show three examples of how PMI representation is reported. The report
includes a visual presentation of the semantic PMI information that can be used for visual verification of
that information. The visual presentation is based only on the semantic PMI and not on the graphical
PMI. The visual presentation should correspond to the expected PMI annotations similar to those on
Figure 51. If the visual presentation does not look right, then the semantic PMI information might be
wrong. The visual presentation is limited by the characters and symbols available in the spreadsheet.
Section 6.6.1 has examples of problems with the visual presentation of the PMI representation.

6.1.2 Datum Reference Frame
The following figures show how a datum reference frame is modeled in a STEP file. Figure 53 shows the
datum worksheet that defines the datum labels in column F.

A B C D E F
datum (6)

ID name description of_shape product_definitional identification
36203|Simple Datum.2 Simple Datum.2 product_definition_shape 56 TRUE B

40518|Simple Datum.3 Simple Datum.3 product_definition_shape 56 TRUE
70983|Simple Datum.5 Simple Datum.5 product_definition_shape 56 TRUE
37096|Simple Datum.1 Simple Datum.l product_definition_shape 56 TRUE
53676|Simple Datum.4 Simple Datum.4 product_definition_shape 56 TRUE
84273|Simple Datum.6 Simple Datum.6 product definition_shape 56 TRUE

[-RE-R RN T R R R

M DO E MO

Figure 53: Entity worksheet (datum)

Figure 54 shows the datum_reference_compartment worksheet with information for the compartments
of a datum reference frame. The compartments are constructed from the base attribute that refers to the
datum entity above and the modifiers attribute. The visual presentation of the compartments is shown in
column H. The parenthetic notation in cell H3 specifies the section number in the CAx-IF recommended
practice for PMI representation related to that information [37].

A B C D H F G H
1 datum reference compartment (26}

%]

PMI Representation

D name description of_shape product_definitional base modifiers compartment

3 (sec. 6.9.7, 6.9.8)
4 | 37101|Perpendicularity.l product_definition_shape 56 TRUE datum 37096 A

5 42036|Position.1 product_definition_shape 56 TRUE datum 37096 A

6 |42041|Position.1 product_definition_shape 56 TRUE datum 36203 B

7 | 51466|Position.3 product_definition_shape 56 TRUE datum 37096 A

8 | 51471|Position.3 product_definition_shape 56 TRUE datum 36203 maximum_material_reguirement (B

9 | 51476|Position.3 product_definition_shape 56 TRUE datum 40518 maximum_material_reguirement iCH)

10 | 53681|Position.d product_definition_shape 56 TRUE datum 53676 D

Figure 54: Entity worksheet (datum_reference_compartment)
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Figure 55 shows the datum_system worksheet with information to combine the datum reference
compartments, defined by the constituents attribute, to create a datum reference frame. The visual
presentation of the datum reference frames is shown in column G.

A B g D E F G
1 datumy system (6
2 PMI Representation
1D name description of_shape product_definitional constituents Datum Reference Frame
3 (Sec. 6.9.7, 6.9.8)
4 | 37106|Perpendicularity.1 product_definition_shape 56 TRUE (1) datum_reference_compartment 37101 A
5 | 42046|Position.1 product_definition_shape 56 TRUE (2) datum_reference_compartment 42036 42041 AlB
6 | 51481 Position.3 product_definition_shape 56 TRUE (3) datum_reference_compartment 51466 5147151476 A | B | C(M}
7 53696/ Position.4 product_definition_shape 56 TRUE (3) datum_reference_compartment 53681 5368653691 D |B|C
8 | 70801 Position Surfacic Profile.2 product_definition_shape 56 TRUE (3) datum_reference_compartment 70786 7079170796 A |B|C
9 | 84091 Perpendicularity.2 product_definition_shape 56 TRUE (1) datum_reference_compartment 84086 E
Figure 55: Datum reference frame example
6.1.3 Dimensional Tolerance

The following example shows how a dimensional tolerance is modeled in a STEP file. Figure 56 and
Figure 57 show the dimensional_characteristic_representation worksheet where information related to
dimensional tolerances is reported.

Column B is the type of dimension, either dimensional_size or dimensional_location.

Column C is a reference to shape_dimension_representation which refers to information for the
dimension name and value.

Column D shows the visual presentation of the dimensional tolerances that correspond to the PMI
annotations in Figure 51.

Column E shows the name attribute of the entity type shown in column B.

Column F  shows the dimension (length  value) associated  with  the
shape_dimension_representation entity in column C.

Column G shows the name of the length value in column F.

Column H shows the plus-minus bounds associated with the dimensional tolerance. The bounds
are defined by plus_minus_tolerance entities.

Column I shows the geometric entities associated with the dimensional tolerances. In this case,
the association is through shape_aspect entities which refer to advanced_face entities. The
geometry entities cylindrical_surface and plane are referred to by the advanced_face attribute
face_geometry.

Section 6.1.5 explains how associated geometry is important to relate dimensional tolerances with
geometric tolerances and datum features.

More columns may show other attributes of dimensional tolerances.

The parenthetic notation in row 3 specifies the section number in the CAx-IF recommended practice for
PMI representation related to that piece of information. For example, recommended practice sections
5.1.1 (column E) and 5.2.1 (column G) specify allowable attribute values shown in those columns.
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A B C
1 |dimensional characteristic representation (10)
2
1D dimension representation

3

35831|dimensional_size 35801 shape dimension_representation 35826
4

40201 |dimensional_size 40171 shape_dimension_representation 40196
5

45336|dimensional_size 45306 shape_dimension_representation 45331
B

43741 |dimensional_size 48711 shape_dimension_representation 48736
7

50541 |dimensional_size 60511 shape_dimension_representation 60536
8

64886 |dimensional_size 64856 shape_dimension_representation 64881
9

67011|dimensional_size 66981 shape_dimension_representation 67006
10

59441 |dimensional_location 69411 shape_dimension_representation 69436
11

80071 |dimensional_location 80041 shape_dimension_representation 80066
12

83181|dimensional_size 83151 shape_dimension_representation 83176
13

Figure 56: Dimensional tolerance example (columns A-C)
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The visual presentation in Figure 57 can be used to do a semantic analysis of the PMI representation
information. The dimension ‘0.75 in cell D11 appears as a reference dimension ‘(.750)’ in Figure 51. In
this case, the STEP file is missing the dimension modifier for a reference dimension. The visual
presentation of the dimension shows that parentheses for a reference dimension are missing.

The feature count for a repetitive dimension, e.g., ‘4X’ and ‘2X’, in cells D6 and D7, respectively, are
derived from the number of geometric surfaces in the associated geometry in column I. In this example,
the feature count is half the number of cylindrical_surface entities in cells 16 and 17. This assumes that a
cylindrical hole is modeled with two half cylindrical surfaces.

A D E [F G H
1 |dimen
2 PMI Representation
ID | Dimensional :dimension name :length/angle  length/angle name : plus minus bounds Associated Geometry
3 Tolerance |(Sec.5.1.1,5.1.5) (Sec.5.2.1) (Sec.5.2.3) (Sec.5.1.1, 5.1.5)
35831|0.438 + .005 diameter '0.438 nominal value -0.005 0.005 (2) cylindrical_surface 23661 23771
(2) advanced_face 23746 23506
(2} shape_aspect 35771 35786
4 (1) composite_group_shape_aspect 35766
40201 ©.438 £.005 diameter 0.438 nominal value -0.005 0.005 (2) cylindrical_surface 23831 23341

(2) advanced_face 23916 23976
(2) shape_aspect 40141 40156
(1) composite_group_shape_aspect 40136

w

45336|4X ©.625 +.005 (diameter 0.625 nominal value -0.005 0.005 (8) cylindrical_surface 10716 10826 10886 10996 11056 11166 11226 11336
(8) advanced_face 10801 10861 10971 11031 11141 11201 11311 11371

(8) shape_aspect 45186 45201 45216 45231 45246 45261 45276 45291

6 (1) composite_group shape_aspect 45181

48741|2X 0.438 +.005 idiameter 0.438 nominal value -0.005 0.005 (4) cylindrical_surface 24571 24681 24741 24851
(4) advanced_face 24656 24716 24326 24386

(4) shape_aspect 48651 43666 48681 43696

7 (1) composite group shape aspect 43646

60541|@2.00 + .01 diameter 2.0 nominal value -0.010.01 (2) cylindrical_surface 9696 9306

(2) advanced_face 97819841

(2) shape_aspect 60481 60496

8 (1) composite_group_shape_aspect 60476

64886/ @1.500+.005 idiameter 1.5 nominal value -0.005 0.005 (2) cylindrical_surface 10546 10656

(2) advanced_face 10631 10691

(2) shape_aspect 64826 64341

9 (1) composite_group shape_aspect 64821

67011 |@1.5 diameter 15 nominal value {2) cylindrical_surface 10546 10656

(2) advanced_face 10631 10691

{2) shape_aspect 66951 66966

10 (1) composite group shape aspect 66946

69441].750 linear distance  [0.75 nominal value (2) plane 9866 10061
(2) advanced_face 9951 10121
1 (2} shape aspect 69381 69396

80071|.821.06 linear distance  [0.82 nominal value -0.06 0.06 (2) plane 11621 13391
(2) advanced_face 11711 14051
12 (2) shape_aspect 79966 79981

83181|@1.065+.003 :diameter 1.065 nominal value -0.003 0.003 (2) cylindrical_surface 2556 2666

(2) advanced_face 2641 2701

(2) shape_aspect 83121 83136

13 (1) composite group shape aspect 83116

Figure 57: Dimensional tolerance example (columns A, D-I)

6.1.3.1 Rounding

The number of decimal places for dimension and geometric tolerance values can be specified in the STEP
file. If specified, the value is always truncated. However, using the ‘Round dimensions and geometric
tolerances’ option the values can be rounded instead. For example, the value 0.5625 could be truncated
to 0.562, however, rounding will show 0.563. Rounding values might result in a better match to graphical
PMI shown by the viewer or expected PMI in the NIST models (Sec. 6.6). This option is different than
the Number Format option (Sec. 5.5.4).
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6.1.4 Geometric Tolerances

The following examples show how geometric tolerances are modeled in a STEP file. Figure 58 and
Figure 59 show the flatness_tolerance worksheet with the reconstructed visual presentation for the
flatness tolerance.

Column D is the magnitude of the flatness tolerance zone which is a reference to a
length_measure_with_unit. As a convenience, the value of the length measure “0.005” is also
shown.

Column E is a reference to the toleranced shape_aspect.

Columns F and G define the unit-basis size and type for the flatness tolerance. Another unit-basis
parameter in column H is not shown.

Column I shows the visual presentation of the FCF for the flatness tolerance with the
corresponding unit-basis and datum feature. It corresponds to the PMI annotations in Figure 51.
Column J is the datum feature associated with the flatness tolerance.

Column K shows the toleranced geometry associated with the flatness tolerance derived from the
toleranced_shape_aspect attribute in column E. The advanced_face entity references the plane
entity.

Section 6.1.5 explains how toleranced geometry is important to relate geometric tolerances with
dimensional tolerances and datum features.

The reconstructed visual presentation of the PMI representation is limited by the character set available in
the spreadsheet. The flatness tolerance symbol (parallelogram) appears somewhat small and misshapen.
The lines for the compartments of the feature control frame are not shown. The combination of the
inverted triangle, vertical line, and ‘E’ in brackets represents the reference to datum feature ‘E’.

1
2

A

(flatng

B C D H F G
ss_tolerance){geometric tolerance with defined area unit) (1)

1D

name description magnitude toleranced_shape_aspect unit_size area_type

73111

Flatness.1 _Geometric tolerance for feature_  0.005 (length_measure_with_unit 73101) shape_aspect 73091 0.25 (length_measure_with_unit 73106) square

Figure 58: Flatness tolerance example (columns A-H)

I 1 K
1
2 PMI Representation
GD&T Datum Feature Toleranced Geometry
3 Annotation (Sec. 6.5) (column E)
= | .005/0.25 X 0.25 idatum_feature 70932 (1) plane 1081
v (1) advanced_face 1696
|

4 | [E]

Figure 59: Flatness tolerance example (columns I-K)
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Figure 60 and Figure 61 show the position_tolerance worksheet with the reconstructed visual
presentations of two position tolerances.

Column D is the magnitude of the position tolerance zone. As a convenience, the value of the
length measure “0.005” is also shown.

Column E is a reference to the toleranced shape_aspect.

Column F is a reference to the associated datum reference frame.

Column G is the modifier applied to the tolerance zone.

Column H shows the visual presentation of the position tolerances with their associated
dimensions. An association between a geometric tolerance and dimension (or datum) is shown if
each has the identical cylindrical_surface entities in the geometric tolerance Toleranced Geometry
(Figure 61, Column J) and dimension Associated Geometry (Figure 57, cells 16 and 17).

Column I shows the FCF of the dimensional tolerance, defined in Figure 57, associated with the
position tolerance. The dimensional_size entities are referred to in column B of Figure 56.
Column J shows the geometry, defined by the toleranced_shape_aspect attribute in column E,
associated with the position tolerance.

Section 6.1.5 explains how toleranced geometry is important to relate geometric tolerances with
dimensional tolerances and datum features.

etric tolerance with datum reference}{geometric tolerance with modifiers){position tolerance) (2}

B - D E F G

name description magnitude toleranced_shape_aspect datum_system modifiers

51491

53706

Position.3 Geometric tolerance for feature  0.05 (length_measure_with_unit 51486) composite_group_shape_aspect 51401 (1) datum_system 51481 maximum_material_reguirement

Position.4 Geometric tolerance for feature  0.05 (length_measure_with_unit 53701) composite_group_shape_aspect 53551 (1) datum_system 53696 maximum_material_requirement

Figure 60: Position tolerance example (columns A-G)

H 1 ]
1
E2 PMI Representation
GD&T Dimensional Tolerance Toleranced Geometry
3 Annotation (Sec. 6.2) {column E})
2X ©.438 +.005 dimensional_size 48711 |(4) cylindrical_surface 24571 24681 24741 24851
E|o0s@|A|B@|C@H (4) advanced_face 24656 24716 24826 24386
(4) shape_aspect 51406 51421 51436 51451
4 (1) composite group shape aspect 51401
4% 9.625 +.005 dimensional_size 45306 :(8) cylindrical_surface 10716 10826 10886 10996 11056 11166 11226 11336
©|0.05@|D|B|C (8) advanced_face 10801 10861 10971 11031 11141 11201 11311 11371
(8) shape_aspect 53556 53571 53586 53601 53616 53631 53646 53661
5 (1) composite_group_shape_aspect 53551

Figure 61: Position tolerance example (columns H-J)

48



6.1.5 Associated and Toleranced Geometry

The previous examples for dimensional and geometric tolerances show columns for associated and
toleranced geometry. The relationship between the geometries is important to understand how the visual
presentation of the feature controls frames (FCF) in Figure 59 and Figure 61 are constructed. Figure 62
shows one of the position tolerances from Figure 51 where the FCF contains a position tolerance, hole
dimension, and datum feature.

Figure 62: Position tolerance feature control frame

Cell G4 in Figure 63 shows the visual presentation of the FCF based on the position tolerance, dimension
tolerance, and datum feature. The key to the visual presentation is that all three components of the FCF
refer to the same geometric entities. The toleranced geometry for the position tolerance in cell J4 should
be read from bottom to top. The composite_group_shape_aspect (CGSA) entity is from the
toleranced_shape_aspect attribute on the position_tolerance entity. CGSA refers to two shape_aspect
entities. Those two entities each refer to a single advanced_face entity which each refer to a
cylindrical_surface entity. The two cylindrical_surface entities (#23831, #23941), highlighted in red, are
the two half cylinders for the surfaces of the hole. Sometimes there is only one cylindrical_surface for a
hole as described in Sec. 6.1.5.

A G H | J
1 |[(geometric tolerance with datum reference)({positi
2 |SeeC4 PMI Representation
ID GD&T Dimensional Tolerance Datum Feature Toleranced Geometry
3 Annotation (5ec. 6.2) (5ec. 6.5) (column E)
42056/ 0.438 + .005 dimensional_size 40171 datum_feature 40517 (2} cylindrical_surface[23831 23941
& |vo20|Aa|B (2) advanced_face 23916 23976
N (2) shape_aspect 42006 42021
| (1) composite_group shape aspect 42001
4 [c]

Figure 63: Toleranced geometry for position tolerance
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Cell K5 in Figure 64 shows the associated geometry for the dimension tolerance in cell DS. Although the
CGSA and shape_aspect entities are different than those in cell J4 of Figure 63, the advanced_face and
cylindrical_surface (#23831, #23941) entities are identical. Therefore, the position and dimension
tolerance are both associated with the same hole geometry. The associated geometry for dimensions is
found through the applies_to attribute on dimensional_size and the relating_shape_aspect and
related_shape_aspect attributes on dimensional location.

A D E [ G H J K
1 |dimensional characteristic representation (10)
2 |SeeCH PMI Representation
ID | Dimensional :dimension name :length/angle : lengthfangle name : plus minus bounds : medifier type 1 modifier type 2 Associated Geometry
3 Tolerance ({Sec.5.1.1,5.1.5): (Sec.5.2.1) (Sec. 5.2.3) (Sec. 5.3) (Sec. 5.3) (Sec.5.1.1,5.1.5)
40201 @.438+.005  idiameter 0.438 nominal value -0.005 0.005 (2) eylindrical_surface[23831 23541
(2) advanced_face 23916 23976
(2) shape_aspect 40141 40156
5 (1) composite group shape aspect 40136

Figure 64: Associated geometry for dimensional tolerance

Cell G5 in Figure 65 shows the associated geometry for datum feature ‘C’. In this case, the
datum_feature entity refers directly to the advanced_face entities. Therefore, the datum feature is also
associated with the same hole as the position and dimension tolerance. The datum feature is also directly
associated with the position tolerance because the position_tolerance entity is a complex entity with
geometric_tolerance_with_datum_reference that refers directly to the datum feature.

A F G
1 |datum feature (&)
2 |See 4 PMI Representation

ID Datum Associated Geometry
3 (Sec. 6.5) (Sec. 6.5)

40517 C (2) eylindrical_surface[23831 23941]
(2) advanced_face 23916 23976

5 (1) datum_feature 40517

Figure 65: Associated geometry for datum feature

If an expected association between a geometric tolerance and a dimension or datum is not reported, then
the associated geometry and toleranced geometry for each tolerance, dimension, and datum should be
checked. A common problem is a position tolerance for a hole being associated with the surfaces of the
hole cylinder and the corresponding hole diameter dimension only being associated with the circular edge
of the hole and the hole surfaces.

In Figure 51 datum feature ‘E’ is associated with a surface profile tolerance. Datum feature ‘E’ is the
surface of the tab. However, in Figure 69, datum feature ‘E’ is associated with two geometric tolerances
shown in cells C21 and C28. Semantically both are correct since both tolerances refer to the same
surface. There is no semantic information in the STEP file to specify which tolerance the datum feature is
presented with.
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6.1.5.1 Multiple Dimensions
In some cases, multiple dimensions might be associated with the same geometric entities. Figure 66
shows the warning message when multiple dimensions are detected. Cells D9 and D10 in Figure 67 show
the multiple dimensions. In this example, there are two diameter dimensions with and without a tolerance
value. Cells K9 and K10 in Figure 68 show the associated geometry for each dimension where they are
both associated with the same cylindrical_surface entities (#10546, #10656). Multiple dimensions might
also be reported for holes that have a counterbore, countersink, and depth.

Status  Qptions Spreadsheet

Generating STEP Entity worksheets
dimensional characteristic representation (18)

Worksheet names are truncated to the first 31 characters

Adding PMI Representation Report

Dimension units: INCH
Multiple dimensions {&1.568 + .85} 1.5 associated with the same geometry
(2) cylindrical surface 18546 18656 [spmiDimtolReport]

Figure 66: Warning message for multiple dimensions

A D E F G H
1 |dimensional characteristic representation (10}
2 |See CH
ID | Dimensional ‘;dimension name ; lengthfangle : lengthfangle name ; plus minus bounds
3 Tolerance (Sec.5.1.1,5.1.5) . (Sec.5.2.1) (Sec. 5.2.3)
64886|@1.500+.005 idiameter .5 nominal value -0.005 0.005
g
67011|@1.5 diameter 1.5 nominal value
10
Figure 67: Multiple dimensions example (columns D-H)
A 4 L M M 8]
1 |dimen
2 |See 4 PMI Representation
ID Associated Geometry
3 {sec. 5.1.1, 5.1.5)
64886 (2) cylindrical_surface 10546 10656
(2) advanced_face 10631 10691
(2) shape_aspect 64826 64841
2 (1) composite_group_shape aspect 64821 Multiple dimensions are associated
67011|(2) cylindrical_surface 10546 10656 with the same geometry. The identical
(2) advanced_face 10631 10691 !nformation in th_is cell should appear
(2) shape_aspect 66951 66966 L"b‘;'):;’_ther Rt e
10 (1) composite_group_shape_aspect 66946

Figure 68: Multiple dimensions example (column K)
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6.1.6 PMI Representation Summary

As a convenience, all of the visual presentations of the datum reference frames, dimensional tolerances,
and geometric tolerances are collected on the PMI Representation Summary worksheet shown in
Figure 69. The annotations in column C are collected from column G in Figure 55, column D in
Figure 57, column I in Figure 59, and column H in Figure 61. The annotations in column C correspond to
the annotations shown in Figure 51.

A B C
nist_ctc_03_asmel_ap242.stp See CAx-IF Recommended Practice]
(2014-12-19T16:21:44+01:00)

1D Entity PMI Representation
73706 angularity tolerance Z|o04|A
v
|
4 [E]
5 |37106 datum system A
6 | 42046 datum system AlB
7 51481 datum system AlB M) | COW)
2 | 53696 datum system D|B|C
9 | 70801 datum system AlB|C
10 | 84091 datum_system E
11| 35831 dimensional characteristic representation ?.433 +.005
12 | 40201 dimensional characteristic representation 0.433 +.005
13 /45336 dimensional characteristic representation 4X .625 £.005
14 | 48741 dimensional characteristic representation 2X 0.438 £.005
15 | 80541 dimensional characteristic representation ©2.00+.01
16 | 64886 dimensional characteristic representation ©1.500 +.005
17 | 67011 dimensional characteristic representation @15
18 | 69441 dimensional characteristic representation '(.?5}
80071 dimensional characteristic representation .82+.06
19 (directed)
20| 83181 dimensional characteristic representation ©1.065 +.003
73111 (flatness tolerance 7| 0.005/0.25x0.25
_(geometric tolerance with defined area unit) WV
|
21 [E]
51491 (geometric tolerance with datum reference 2X 0.438 £.005
_(geometric tolerance with modifiers) @ | 20,050 (M) | A B0 | C ™)

]
ra

position tolerance)
53706 (geometric tolerance with datum reference 4X 0.625 +.005

_(geometric tolerance with modifiers) @ |e0oso® |D|B|C
23 position tolerance)
42056 [geometric tolerance with datum reference 0.438 +.005
position tolerance) @ | 00.020 |A | B
v
|
24 [cl
62431 (geometric tolerance with datum reference $2.00+.01
25 (position tolerance) @ |woos|D|B|C
66861 (geometric tolerance with datum reference 01.500 +.005
26 position tolerance) & |e0.080|D|B|C
68596 (geometric tolerance with datum reference ©1.500 +.005
27 position tolerance) Ploowo|D|B|C
70811 (seometric tolerance with datum reference o006 |A|B|C
surface profile tolerance) v
|
28 [E]
3 Summary Header | PMI Representation Summary PMI Representation Cg

Figure 69: PMI Representation Summary worksheet

If a STEP file that was generated from a NIST CAD model from the MBE PMI Validation and
Conformance Testing Project [38] is processed and the file can be recognized as having been generated
from one of the CAD models, then the PMI Representation Summary worksheet is color-coded by the
expected PMI annotations (Sec. 6.6.1).
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6.1.7 PMI Representation Coverage Analysis

Coverage analysis counts the number of occurrences of a PMI element in a STEP file. Figure 70 shows
the worksheet that is generated for coverage analysis of PMI Representation. Column A in rows 4
through 26 contain different types of PMI elements related to geometric and dimensional tolerances.
Tolerances and modifiers show their associated symbol. The numbers in parentheses refer to the sections
in the CAX-IF recommended practice for the representation of PMI [37] where there is implementation
guidance for that type of PMI element.

Column B contains the number of occurrences of that type of PMI element in the file. Comparing the
count to the number of expected PMI elements is a way to verify the PMI in the STEP file and resolve
and modeling issues. If a STEP file that was generated from a NIST CAD model is processed, then the
PMI Representation Coverage worksheet is color-coded by the expected number of PMI elements (Sec.
6.6.2).

sp3 1101 3de.stp
(2014-08-13T12:42:32+02:00)

ra

PMI Element
3 | [See Help = Analyze = PMI Coverage Analysis) Count
4 |flatness_tolerance O 1
5 |perpendicularity_tolerance |
& | position_tolerance &
7 |surface profile_tolerance —
8 |tolerance zone diameter (6.9.2)
% projected @ (6.9.2.2)

10 junequally_disposed @ or UZ (6.9.4)

11 |dimensional location (5.1.1)

dimensional size (5.1.5)

angular location (5.1.2)

dimension association to geometric tolerance (5.1)
bilateral tolerance (5.2.3)

diameter @ (5.1.5)

linear distance (5.1.1)

datum (6.5)

datum system (6.9.7)

multiple datum features (6.9.8)

datum feature association to geometric tolerance (6.1)

Pe L2 P2

=] noLn

CJR = R ¥ R w = ]

circle datum target (6.6.1)

free_state ® (6.9.3 or6.9.7)
least_material_requirement {© (6.9.3 or 6.9.7)
maximum_material_requirement @ (6.9.3 or 6.9.7)
document identification (3, see Header worksheet)

LR

Ll w =M w e a|e s |o 2 bR |R =l R e

[ % R o R o B L% T S R ' |
P L M2

(= )]

3 summary Header | PMI Representation Coverage

Figure 70: PMI Representation Coverage worksheet
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Table 2 shows the complete list of PMI Elements that can appear in column A above. Tolerances and
modifiers show their associated symbol. The numbers in parentheses refer to the sections in the CAx-IF
recommended practice for the representation of PMI.

Table 2: All PMI Elements for PMI Representation Coverage

angularity_tolerance £ linear distance inner/outer (5.1.1) depth T

circular_runout_tolerance A curve length (5.1.5) derived_feature @& (6.9.3)
coaxiality_tolerance @ thickness {5.1.5) distance_variable DV (6.9.7)
concentricity_tolerance @ toroidal radius/diameter (5.1.5) each_radial_element ERE (6.9.3)
cylindricity_tolerance = controlled radius CR (5.3) envelope_requirement © (5.2.1)
flatness_tolerance dimensicn basic (5.3) free_state &) (6.9.3 or 6.8.7)
line_profile_tolerance — reference dimension (5.3) free_state_condition & (5.3)
parallelism_tolerance 4 square o (5.3) independency () {5.2.1)
perpendicularity_tolerance L dimension qualifier (5.4) least_material_condition @
position_tolerance & measure qualifier least_material_requirement © (6.9.3 or 6.9.7)
roundness_tolerance () datum (6.5) least_square_association_criteria (GG) (5.3)
straightness_tolerance - datum system (6.9.7) line 5L (6.9.7)

surface_profile_tolerance o datum with axis system (6.9.7) line_element LE (6.9.3)

symmetry_tolerance = datum with modifiers (6.9.7) local_size_defined_by_a_sphere (LS} (5.3)
total_runout_tolerance . multiple datum features (6.9.8) major_diameter MD (6.9.3)

tolerance zone diameter (6.9.2) datum feature association to geometric tolerance (6.1) [maximum_inscribed_association_criteria (GX) (5.3)
tolerance zone within a cylinder (6.9.2) all datum targets maximum_material_condition @

tolerance zone spherical diameter (6.9.2) point datum target (6.6.1) maximum_material_requirement @ (6.9.3 or 6.9.7)
tolerance zone other (6.9.2) line datum target (6.6.1) maximum_rank_order_size (SX) (5.3)
all_over « @ (6.3) rectangle datum target (6.6.1) median_rank_order_size (5M) (5.3)
all_around = (6.4.2) circle datum target (6.6.1) mid_range_rank_order_size (5D} (5.3)
between <3 (6.4.3) circular curve datum target (6.6.1) minimum_circumscribed_association_criteria (GN) (5.3)
affected plane tolerance zone (6.9.2.1) curve datum target (6.6.2) minimum_rank_order_size (SN) (5.3)
projected & (6.9.2.2) area datum target (6.6.2) minor_diameter LD (6.9.3)

non-uniform tolerance zone (6.9.2.3) placed datum target geometry (6.6.3) not_convex NC (6.9.3)

unequally_disposed @ or UZ (6.9.4) movable datum target (6.6.4) orientation =< [6.9.7)

tolerance with max value (6.9.5) any_cross_section ACS (5.3) pitch_diameter PD (6.9.7)

unit-basis tolerance (6.9.6) any_longitudinal_section ALS (6.9.7) plane PL (6.9.7)

composite tolerance (6.9.9) any_part_of_the feature /Length (5.3) point PT (6.9.7)

intersection/orientation plane indicator arc_length — range_rank_order_size (SR} (5.3)
dimensions (location+size) area_diameter_calculated_size (CA) (5.3) reciprocity_requirement & (6.9.3)
dimensional location (5.1.1) associated_least_square_feature & (6.9.3) regardless_of feature_size &

dimensicnal size (5.1.5) associated_maximum_inscribed_feature & (6.9.3) separate_requirement SEP REQT (6.9.3)
angular location (5.1.2) associated_minimum_inscribed_feature @ (6.9.3) simultanecus_requirement 5IM REQT
angular size (5.1.6) associated_minmax_feature © (6.9.3) slope =

directed dimension +{5.1.1) associated_tangent_feature @ (6.9.3) specific_fixed_cross_section SCS (5.3)
oriented dimensional location (5.1.3) average_rank_order_size (3A) (5.3) spotface SF

derived shapes dimensional location (5.1.4) basic [BSC] (6.9.7) statistical_dimension <S8T> (5.3)

location with path (5.1.7) circumference_diameter_calculated_size (CC) (5.3) statistical_tolerance <5T= (6.9.3)

repetitive dimensions 'nX' (5.1, User Guide 5.1.3) common_tolerance CT (5.3) tangent_plane T (6.9.3)

dimensicon association to geometric tolerance (5.1) [common_zone CZ (6.9.3) translation [» {6.9.7)

bilateral tolerance (5.2.3) conical_taper = two_point_size (LP) {5.3)

non-bilateral tolerance (5.2.3) contacting_feature CF (6.9.7) united_feature UF (6.9.3)

type qualifier (5.2.2) continuous_feature <CF> (5.3) volume_diameter_calculated_size (CV) (5.3)
value range (5.2.4) counterbore saved views (9.4)

limits and fits (5.2.5) countersink . editable text (7.4)

diameter @ (5.1.5) degree_of_freedom_constraint_u u (6.9.7) document identification (3, see Header worksheet)
radius R (5.1.5) degree_of_freedom_constraint_v v {6.9.7) ASME dimensioning standard (4, Fig. 1)
spherical diameter 59 (5.1.5) degree_of_freedom_constraint_w w (6.9.7) ASME modeling standard (4, Fig. 2)

spherical radius 5R (5.1.5) degree_of_freedom_constraint_x x (6.5.7) 150 dimensioning standard (4, Fig. 1)

curved distance (5.1.1) degree_of_freedom_constraint_y y (6.9.7) 150 modeling standard (4, Fig. 2)

linear distance (5.1.1) degree_of_freedom_constraint_z z (6.8.7) default tolerance decimal places (4.1)
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6.2 PMI Presentation (Graphical PMI)

PMI presentation (also known as graphical PMI) presents GD&T annotations as a visual representation of
geometric elements such as lines and arcs as part of the CAD model, i.e., how the annotation is drawn on
the model. PMI presentation is not intended to be computer-interpretable and does not carry any semantic
representation information although it can be linked to its corresponding semantic representation. The
CAx-IF defines recommended practices for PMI presentation [37]. Syntax errors related to
nonconformance to the recommended practices are highlighted in red in the Status tab and in the relevant
entity worksheets (Sec. 6.5).

Figure 71 through Figure 73 show how PMI presentation is reported in the spreadsheet. The report for
PMI presentation only contains information about the graphical elements (points, lines, colors) needed to
draw PMI annotations. PMI presentation information is always reported on the
annotation_curve_occurrence (as in this example), tessellated_annotation_occurrence, or
annotation_occurrence worksheets.

e Columns B, C, and D show the entity attributes.

e  Column E shows the name attribute of the geometric_curve_set in column D.

o Column F shows the element attributes of the geometric_curve_set. In this case, the elements
refer to polyline entities.

e Column G shows the curve_style associated with the presentation_style assignment in column
C.

e Column H shows the color associated with the curve_style in column G.

e Column I shows the annotation plane associated with the annotation.

e Column J shows the geometry that the annotation is attached to. If associated geometry is
missing, then there is no cross-highlighting between the annotation and geometry.

e Column K shows the associated PMI representation entities.

e Not shown are columns for PMI presentation validation properties and Saved Views.

A B C D
1 annotation curve occurrence (30)

D name styles item

35736 |Linear Size.1 (1) presentation_style_assignment 35731 geometric_curve_set 35726

36196|Simple Datum.2 (1) presentation_style_assignment 36191 geometric_curve_set 36186

37056|Perpendicularity.1 (1) presentation_style_assignment 37051 geometric_curve_set 37046

40131|Linear Size.2 (1) presentation_style_assignment 40126 geometric_curve_set 40121

40511 |Simple Datum.3 (1) presentation_style_assignment 40506 geometric_curve_set 40501

Figure 71: PMI presentation example (columns A-D)
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G H

PMI Presentation

name
(Sec. 8.4)

elements
(Sec.8.1.1)

color
(Sec. 8.5)

presentation style
(Sec. 8.5)

diameter dimension

(35) polyline 32921 32996 33061 33151 33241 33271 33296
3330133636 33720 33896 33986 34016 34106 34196 34226 34316
34406 34496 34586 34786 34856 34946 35036 35066 35156 35246
35336 35426 35626 35651 35676 35691 35706 35721

curve_style 35732 idraughting_pre_defined_colour 35734

datum

(6) polyline 35941 36006 36111 36141 36156 36181

curve_style 36192 idraughting_pre_defined_colour 36194

perpendicularity

(13) polyline 36281 36311 36491 36566 36631 36661 36751
36841 36906 26936 36961 37011 37041

curve_style 37052 idraughting_pre_defined_colour 37054

diameter dimension

(35) polyline 37316 37391 37456 37546 37636 37666 37691
37756 38031 38121 38291 33381 38411 38501 38591 38621 38711
38801 38891 38981 39181 39251 39341 39431 39461 39551 39641
39731 39821 40021 40046 40071 40086 40101 40116

curve_style 40127 :draughting_pre_defined_colour 40129

datum

(4) polyline 40426 40456 40471 40496

curve_style 40507 idraughting_pre_defined_colour 40509

Figure 72: PMI presentation example (columns E-H)

plane
(5ec. 9.1)

Associated Geometry
(Sec.9.3.1)

Associated Representation
(5ec. 7.3)

annotation_plane 69461 {(2) cylindrical_surface 23661 23771 dimensional_size 35801
(Projview.1) (2) advanced_face 23746 23806

(2) shape_aspect 35771 35786

(1) composite_group_shape_aspect 35766
annotation_plane 69461 {(2) cylindrical surface 23661 23771 datum_feature 36202
(ProjView.1) (2) advanced face 23746 23806

(1) datum_feature 36202
annotation_plane 69461 {(2) cylindrical_surface 23661 23771 perpendicularity_tolerance 37116
(ProjView.1) (2) advanced_face 23746 23806

(2) shape_aspect 37066 37081

(1) composite_group shape_aspect 37061
annotation_plane 69461 {(2) cylindrical_surface 23831 235941 dimensional_size 40171
(ProjView.1) (2) advanced_face 23916 23976

(2) shape_aspect 40141 40156

(1) composite_group _shape_aspect 40136
annotation_plane 69461 {(2) cylindrical_surface 23831 23341 datum_feature 40517
(Projview.1) (2) advanced_face 23916 23976

(1) datum_feature 40517

Figure 73: PMI presentation example (columns I-K)
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6.2.1 PMI Presentation Coverage Analysis

Coverage analysis counts the number of occurrences of a PMI element in a STEP file. Figure 74 shows
the worksheet that is generated for coverage analysis of PMI presentation. Rows 4 through 35 of column
A contain the recommended names [37] that can be associated with a PMI annotation.
correspond to the values in column E in Figure 72. There is no semantic meaning associated with the
names. PMI presentation assumes a semantic meaning through its association with PMI representation as

shown in column K of Figure 73.

(=i R B = R ) R o R S

L S T T L e B o T T T o e I S e e
fo= R T S e e S o i R - S - R R O S I e e T O e 0 S T RN e

A

B

nist_ctc_03_asmel_ap242.stp

PMI Presentation Names

angularity
circular runout
circularity
coaxiality
concentricity
cylindricity
flatness
parallelism
perpendicularity
position

profile of line
profile of surface
roundness
straightness
symmetry

total runout
general tolerance

Count
1

linear dimension
radial dimension
diameter dimension
angular dimension
ordinate dimension
curve dimension
general dimension

datum
datum target

note

label

surface roughness
weld symbol
general note

over riding style set

See Help = PMI Coverage Analysis

3 PMI Presentation Coverage

Figure 74: PMI Presentation Coverage worksheet
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6.3 Validation Properties

Validation properties are an important tool to verify the information in a STEP file. The properties
include geometric, PMI, assembly, annotation, attribute, and tessellated validation properties. For
example, geometric validation properties are characteristics of solid and surface models, such as area,
volume, and centroid. Geometric validation properties could be written to a STEP file when it is exported
from a CAD system. When the STEP file is imported to a receiving CAD system, that system can
compute the same validation properties and compare them to the values from the originating system in the
STEP file. If the computed validation properties are within an agreed tolerance to the original validation
properties, then the exchange of geometric information has been validated. The CAx-IF defines
recommended practices for validation properties [39]. Syntax errors related to nonconformance to the
recommended practices are highlighted in red in the Status tab and in the relevant entity worksheets (Sec.
6.5).

Figure 75 and Figure 76 shows a validation properties report. The report always appears on the
property_definition worksheet. The rows can be sorted by any of the column attributes. The validation
properties are shown in the yellow and green columns E, G, I, K, and M. Row 3 contains the names of
the type of value in those columns. Properties not colored yellow and green are not validation properties
as defined by the recommended practice. The values in cells 17, [10, and 116 are cartesian coordinates.
Empty cells E13 and E14 show that values for those attributes were not specified in the STEP file. If no
values for units and exponent appear in rows K and M, then none are required based on the type of value
in row L.

The hidden columns F, H, J, L, and N can be shown by clicking on the plus (+) signs above the columns
or the “2” in the upper left corner. Those columns contain the entity attribute name and ID for the
corresponding validation property value in the column to the left. Opening the hidden columns shows
where the validation property values come from in the STEP file. The hidden columns F, H, and J are
shown in Figure 77. Columns L, M, and N are not shown. For example, the value in cell G4 “surface
area measure” comes from the measure_representation_item name attribute of entity ID 393. The
expanded columns can be hidden again by clicking on the minus (-) signs above the columns or the “1” in
the upper left corner.

A B Z D

1 |property definition (35)

2

3 ID| ~ name - description - definition -
! 385 shape for solid data with which properties are associated shape_aspect 384

5 394|geometric validation property area of C1_SOLID shape_aspect 384

6 403 |geometric validation property volume of C1_SOLID shape_aspect 384

7 407|geometric validation property centroid of C1_SOLID shape_aspect 384

8 416|geometric validation property area of C1_SOLID product_definition_shape 383

9 425|geometric validation property volume of C1_SOLID product_definition_shape 383

10 429|geometric validation property centroid of C1_SOLID product_definition_shape 383

11 482|pmi validation property number of views of C1_SOLID product_definition_shape 383

12 486|pmi validation property number of annotations of Default (characterized_object) (draughting_model) 434
13 489|DESCRIPTION user defined attribute product_definition 382

14 495|MODELED_BY user defined attribute product_definition 382

15 502|attribute validation property  part user attributes of C1_SOLID product_definition_shape 383

16 513|geometric validation property centroid of C1_SOLID product_definition_shape 511

Figure 75: Validation properties example (columns A-D)




E ] | K M
1
2 Validation Properties
3 representation name - value name - value [ units | exponent| ~
4 |{1) shape_definition_representation.definition 387
5 |surface area surface area measure 60000: INCH 2
6 |volume volume measure 1000000 INCH 3
7 |centroid centre point 0.0 50.0 0.0
8 |surface area surface area measure 60000 INCH 2
9 |volume volume measure 1000000 INCH 3
10 |centroid centre point 0.0 50.0 0.0
11 [number of views number of views 1
12 [number of annotations number of annotations 0
13 DESCRIPTION
14 MODELED_BY
15 |part user attributes part user attributes 2
16 |centroid centre point 50.0 50.0 -50.0
Figure 76: Validation properties example (columns E-O)
1 = =
i
E F G H 1 i
1
2 Validation Properties
3 representation name - attribute -] value name | attribute2 | value -} attribute3 -
4 |(1) shape definition_rep ion.defi 387
5 |surface area i#395 representation.name _ surface area measure  :#393 measure_representation_item.name 60000;#393 measure _representation_item.value_companent
6 lvolume e \MADATED Lname volumemeasure #4032 measure representation item.name | 1000000;#402 measure repr ion_item.value_con
7 |centroid #408 repr ion.name _centre point #406 cartesian_point.name 0.0 50.0 0.0 :#406 cartesian_point.coordinates
8 |surface area #417 representation.name  |surface area measure  [#415 measure_representation_item.name 60000 |#415 mEasurexrepresentahonfitem,vaiuermmpunent
9 |volume #426 tation.name volume measure #4274 measure _r ion_item.name 24 measure_repr 1_item.value
10 [centroid i i i #430 representation.name  jcentre point ..|#428 cartesian_point.name - o 0.0 50.0 0.0 i#428 cartesian point.coordinates e
11 |number of views #483 representation.name  number of views #4381 value_representation_item.name 1/#481 value_representation_item.value_component
12 \number of annotations #487 representation.name  number of i #485 value_rep ion_item.name 0:#485 value_representation_item.value_component
13| #4933 representation.name  DESCRIPTION #492 descriptive_representation_item.name #492 descriptive_representation_item.description
14 #4593 rep ion.name MODELED BY #4598 descriptive_rep ion_item.name #498 descriptive_representation_item i
15 |part user attributes |#503 representation.name | partuser attributes  [#501value_representation_item.name . . 2|#501 value_representation_item.value_component
16 |centroid :#514 representation.name  icentre point ;#512 cartesian_point.name 50.0 50.0 -50.0 :#512 cartesian_point. d|

Figure 77: Validation properties example with expanded columns (columns E-J)

Validation properties are also reported on their associated annotation, dimension, geometric tolerance,
and shape aspect entities. The report includes the validation property name and names of the properties.
Some properties are reported only if the analysis for semantic PMI is selected. Other properties and user
defined attributes are also reported.

6.3.1 Semantic Text

Another type of validation property is known as semantic text where explicit text strings in the STEP file
can be associated with part surfaces similar to semantic PMI. Figure 51 shows text strings SWITCH
MOUNTING LOCATIONS and 2 COPLANAR SURFACES as graphical PMI. The semantic text will appear in
the spreadsheet on shape_aspect and other related entities. A message in the Status tab will indicate
when semantic text is added to entities.
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6.4 Inverse Relationships

In a STEP schema, an entity attribute whose value consists of entity references, in which the referenced
entity has attributes referring to the referencing attribute’s entity is called an inverse attribute. This
establishes an inverse relationship [40] that is explicitly defined in a STEP schema.

Figure 78 is an entity worksheet for shape_aspect_relationship that shows the entity relationships
established between the attribute values for relating_shape_aspect and related_shape_aspect in columns
D and E.

A B C D E
1 |shape|aspect relationship (71)
2
3| ID name description relating_shape_aspect related_shape_aspect
4 | 35781|Linear 5ize.1 composite_group_shape_aspect 35766 shape_aspect 35771
5 | 35796|Linear 5ize.1 composite_group shape aspect 35766 shape aspect 35786
6 36201|Simple Datum.2 datum_feature 36202 datum 36203
7 | 37076 |Perpendicularity.1 composite_group_shape_aspect 37061 shape_aspect 37066
8 37091|Perpendicularity.1 composite_group_shape_aspect 37061 shape_aspect 37081
9 |40151|Linear Size.2 composite group shape aspect40136 shape aspect40141
10  40166|Linear Size.2 composite_group_shape_aspect 40136 shape_aspect 40156
11  40516|Simple Datum.3 datum_feature 40517 datum 40513
12 | 42016|Position.1 composite _group shape aspect42001 shape aspect 42006
12 A9037 1Dacitinm 1 comnnncito ororn chong gonaet A2001 baong ccnort A20721

Figure 78: Entity worksheet (shape_aspect_relationship)

Figure 79 and Figure 80 show how inverse relationships are shown on the datum entity based on
shape_aspect_relationship shown above. Column G shows the relationship between datum and other
entities. Column H, with the ‘Used In’ header, shows where datum is referred to from other entity
attributes although not by an inverse relationship established by a STEP schema. The tooltip in the
Options tab for the Inverse Relationships selection shows the list of entities for which some attributes
with Inverse and Used In relationships that are reported.

A B C D E F
1 datum (6}

D name description of_shape product_definitional identification

36203 |Simple Datum.2 Simple Datum.2 product_definition_shape 56 TRUE B

o

40518|Simple Datum.3 Simple Datum.3 product_definition_shape 56 TRUE

70983 |Simple Datum.5 Simple Datum.5 product_definition_shape 56 TRUE
37096|Simple Datum.1l Simple Datum.l product_definition_shape 56 TRUE
53676|Simple Datum.4 Simple Datum.4 product_definition_shape 56 TRUE
84273 |Simple Datum.6 Simple Datum.6 product_definition_shape 56 TRUE

[N=R-- RN -
m Qo m

Figure 79: Inverse Relationships and Used In example (columns A-F)
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INV-relating_shape_aspect Used In

(1) datum_feature 36202 (8) datum_reference_compartment.base 42041 51471 53686 62416 66846 68581 70791
4 77256

(1) datum_feature 40517 {7) datum_reference_compartment.base 51476 53691 62421 66851 68586 70796 77261

(1) datum_feature 70982 (1) datum_reference_compartment.base 84086

(1) datum_feature 75912 (6) datum_reference_compartment.base 37101 42036 51466 70786 73696 77251
(

(

1) datum_feature 77502 (4) datum_reference compartment.base 53681 62411 66841 68576
1) datum_feature 84272

W00 |~ on Ln

Figure 80: Inverse Relationships and Used In example (columns G-H)

6.5 Syntax Errors

Syntax errors, related to nonconformance to a CAx-IF recommended practice, are highlighted in red in
the Status tab and on the relevant entity worksheets. Figure 81 shows a syntax error displayed in the
Status tab associated with an annotation_curve_occurrence entity while generating the PMI Presentation
report. The second line of the syntax error refers to specific sections, figures, or tables in the relevant
recommended practice that provides the guidance for the correct implementation of that information.
Figure 82 shows a  warning  message  highlighted in  yellow  related to
dimensional_characteristic_representation.

Status  Options Spreadsheet

type_qualifier (6)

value_format_type_qualifier (&)

annotation_curve_occurrence (22)

Adding PMI Presentation Report

Syntax Error: For Saved Views, missing required reference to 'mapped_item® on (characterized_representation)(d
(Representation and Presentation of PMI (AP242), Sec. 9.4.2.1, Fig. 86)

annotation_plane (7)

Figure 81: Syntax error related to annotation_curve_occurrence

Status  QOptions Spreadsheet

Generating STEP Entity worksheets

dimensional_characteristic_representation (6)

Worksheet names are truncated to the first 31 characters

Adding PMI Representation Report

Dimension units: INCH
Associated Geometry for a "diameter’ dimension is only a ‘edge curve'. Check that f
datum (4)

Figure 82: Warning message related to dimensional _characteristic_representation
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Entity types that have any syntax or warning messages are highlighted in gray on the Summary worksheet
as shown in Figure 83. The red triangle in the upper left corner of a cell indicates that there is a comment
shown in the yellow box. Entities with errors are also highlighted in red in the Status tab with the
messages about Formatting Worksheets.

A B C D E F G
STEP Directory C:\Users\lipman\Documents\Analyzer\User Guide

2 |STEP File nist ctc 05 asmel ap242.stp

3 | Excel File nist_ctc 05 asmel ap242-sfa.xlsx

4 | Timestamp 2014-12-19T16:03:21+01:00

5 Total Entities A3400

& Schema AP242e1

7 |Standards 1S0 16792

8 |Dimension Units INCH

g

10 Entity Count

1 circular runout tolerance [PMI Representation] 3

12 coaxiality tolerance [PMI Representation] 1

13 datum 4

14 datum_ feature [PMI Representation] 2

15 datum_reference compartment [PMI Representation] 8

16 datum reference element [PMI Representation] .« [There are Errors or Warnings for at least one entity
17 datum_system [PMI Representation] of this type. See Help > Analyze > Syntax Errors
15 dimensional characteristic representation [PMI Representation] h 6

18 dimensional location 5
20 dimensional size 1
21 perpendicularity tolerance [PMI Representation] 2
22 placed datum target feature [PMI Representation] 2
23 plus minus tolerance 2
24 roundness tolerance [PMI Representation] 1
25 shape dimension representation 6
26 straightness tolerance [PMI Representation] 1
27 tolerance value 2
28 tolerance zone 1
29 tolerance zone form 1
30 total runout tolerance [PMI Representation] 2
31 annotation curve occurrence 22
32 annotation plane 7
33 camera model d3 2

[characterized representation) h
34 [draughting model) [Properties] 2
» Summary | Header PMI Representation Summary PMI Representation Coverage circular_runout_tole

Figure 83: Entities with errors or warnings highlighted on Summary worksheet
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Figure 84 shows the (characterized_representation)(draughting_model) worksheet where the syntax
errors from Figure 81 are highlighted in cells C4 and C5. The comment is same text displayed in the
Status tab in Figure 8I. Although the syntax error was detected when processing
annotation_curve_occurrence entities, the actual error is related to the items attribute on the
(characterized_representation)(draughting_model) entity.

A B T D
1 |(characterized representation){draughting model) {2}

3 [ID| name items context_of_items
45 MBD_A (1) camera_model_d3 47 (13) draughting_callout 267 N (geometric_representation_context) (global_uncertainty_assigned |
4 269 273 274 275 276 277 278 279 280 281 282 285 r— p———p

) For Savea ‘.ﬁeu-u‘s, missing required reference to 'mapped_item’
46|MBD_B (1) camera_model_d3 48 (10) draughting callout 268  (glon (characterized_representation)(draughting_model).items

269 270 271 272 283 284 286 237 233 {g|(Representation and Presentation of PMI (AP242), Sec. 9.4.2.1,
Fig. 86) See Websites > Recommended Practices or the linkin [
row 2.

AR =T =R = ()

Figure 84: Syntax error on (characterized_representation)(draughting_model)

Figure 85 shows the dimensional_characteristic_representation worksheet where the warning message
from Figure 82 is shown with a comment for the cell in column L. The comment means that the
associated geometry for this hole diameter is an edge curve when a hole diameter would usually be
associated with cylindrical surfaces.

Associated Geometry
(sec. 5.1.1, 5.1.5)

2) edge_curve 2685 2691
2) shape_aspect 1004 1005
2) trimmed_curve 3892 3893
2) shape_aspect 1006 1007
2) trimmed_curve 3898 3899
S g LA Diameter dimension {column E) is not

1) edge_curve 2839 associated with curved surfaces. Check that
1) shape_aspect 1010 this is the intended association.

2) trimmed_curve 3893 3895
2) shape_aspect 1012 1013
1) trimmed_curve 3898

2) shape_aspect 1014 1015

(
{
(
{
(
{
(
{
(
(
(
{

Figure 85: Warning message on dimensional_characteristic_representation
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There are also some other explanatory comments for the headings in row 3 on several types of worksheets
as shown in Figure 86.

DAL I

8 —-— See Help > User's Guide (section 5.1.32) for an explanation of how the dimensions —
Dimensional :dibelow are constructed. ***** Dimension units: INCH ***** Repetitive dimensions
Tolerance | (4(e.g., 4X) might be shown for diameters and radii. They are computed based on the
5.000 +.008 <ST> i numier Df_cviindricai, spherical, and i:DrDiu'_ai surfaces associqi:ed Wit a dimension
. - (see Associated Geometry column to the right) and, depending on the CAD system,
might be off by a factor of two, have the wrong value, or be missing. ***** See the |
[1.250] lid PMI Representation Summary worksheet to see how the Dimensional Tolerance
below compares to the expected PMI.

[1.250] linear distance {1.25 nominal value NR2 1.3
@¥10.000+£.001 :diameter 10.0 nominal value -0.001 0.001 NRZ 2.3
[2.000] linear distance (2.0 nominal value NR2 1.3
[2.000] linear distance (2.0 nominal value NR2 1.3

Figure 86: Cell comment for dimensional tolerances
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6.6 Color-coding Results for NIST CAD Models

If a STEP file is processed that was generated from a NIST CAD model from the MBE PMI Validation
and Conformance Testing Project [38] and the file can be recognized as having been generated from one
of the CAD models, then the PMI Representation Summary and PMI Representation Coverage
worksheets are color-coded by the expected PMI annotations.

6.6.1 Representation Summary

The PMI Representation Summary worksheet is color-coded by the expected PMI annotations in a NIST
test case drawing. Figure 87 is a color-coded worksheet for a STEP AP242 file generated from CAD
model based on NIST test case CTC 58. A similar worksheet based on NIST test case CTC 3, without
color-coding, is shown in Figure 69.

The color-coding is determined by comparing the expected PMI annotations for a NIST test case, that are
stored in SFA, with the PMI Representation generated by SFA in column C. The comparison has nothing
to do with the graphic PMI in the STEP AP242 file, only the semantic PMI.

The legend at the bottom of column C describes the color-coding.

Green is an exact match to an expected PMI annotation in the NIST test case drawing.
Cyan is a partial match.

Yellow is a possible match.

Red is no match.

For partial and possible matches, the best match to expected Similar PMI is shown in column D. At the
bottom of column C are the expected Missing PMI annotations not found in the STEP file. The red
triangles in the upper right corners of cells C3 and D3 indicate that there is a cell comment that explains
the meaning of the cells in columns C and D.

In this example, cell C14 is missing the diameter symbol for a hole dimension. This means that the
dimensional_characteristic_representation entity (#906) refers to a dimensional_location entity instead
of a dimensional_size entity. Dimensional_size should almost always be used for hole diameters.
Cell D14 shows the expected Similar PMI, from the NIST test case drawing for the hole diameter, that
includes the diameter symbol.

Cell C15 is colored red because the reference dimension value ‘(2.500)’ found in the STEP file does not
appear in the NIST test case drawing. Conversely, the missing PMI in cells C33 and C34 show that those
two basic dimensions are found in the NIST test case drawing but not in the STEP file.

The shape of the placed datum targets in cells C18 and C19 are incorrect. This means that the description
attributes on the placed_datum_target_feature entities (#1103, #1104) are ‘point’ instead of ‘rectangle’.

8 https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist _ctc_05_asmel rd.pdf
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https://s3.amazonaws.com/nist-el/mfg_digitalthread/nist_ctc_05_asme1_rd.pdf

A B C D
1 nist_ctc 05 asmel ap242.stp See CAx-IF Recommended Practice for Repre
2
3 |ID  Entity PMI Representation ~ similar PMI
4 | 946 circular runout tolerance A | .035| A-B
5 | 947 circular runout tolerance A | .025| A-B
6 | 948 circular runout tolerance A | .025 | A-B
7 | 960 coaxiality tolerance | 903 | A
8 | 964 datum system A
9 | 965 datum system B
10| 967 datum system C
11| 968 datum system [}
12 | 969 datum system A-B
13| 903 dimensional characteristic representation |5.000 + .008 <ST=
14 | 906 dimensional characteristic representation  10.000 £ .001 @10.000 + .001
15| 908 dimensional characteristic representation 12.500]
16 | 955 perpendicularity tolerance llo|c
17 | 956 perpendicularity tolerance llom|o
18 | 1103 roundness tolerance C1 (point) C1 (rectangle)
19 | 1104 roundness tolerance D1 (point) D1 (rectangle)

961 roundness tolerance | 002

W
|

20 [A]
21| 957 straightness tolerance - | .005

962 total runout tolerance 4| 001 A ©10.000 + .001

U] .002]A
S
|

22 [B]
23| 963 total runout tolerance J].015|B
24
25 Expected PMI
26 See Help = NIST CAD Models
27 Exact match
28 Partial match
24 Possible match
30 Mo match
3
32 Entity Type Missing PMI
33 dimensional_characteristic_representation |[1.250]
34 dimensional_characteristic_representation |[2.000]

Figure 87: Color-coded PMI Representation Summary worksheet for CTC 5
There are several problems with the total_runout_tolerance in cell C22. Because there are more

problems it is colored yellow as a possible match. The magnitude of the tolerance zone is *.001” instead
of £.002’.
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The feature control frame (FCF) for the similar PMI in cell D22 shows that there is a dimension tolerance
and datum feature associated with the geometric tolerance. Figure 88, from NIST test case drawing for
CTC 5, shows a large inner diameter surface with the total runout tolerance. That surface also has a
diameter dimension that is defined as datum feature ‘B’. Semantically, those three PMI elements all refer
to the same large inner diameter surface in the test case drawing. Therefore, the similar PMI in cell D22
is also a correct visual presentation of the FCF for the PMI annotation. Cell C22 is missing the diameter
dimension and datum feature because the geometric tolerance is not associated with the same geometric
surfaces as the diameter dimension and datum feature. This can be confirmed by checking the toleranced
or associated geometry for the total_runout_tolerance, the dimensional_characteristic_representation,
and datum_feature. The geometric tolerance must have the exact same toleranced or associated
geometry to be able to show the FCF in cell C22 as it appears in cell D22. The association of toleranced
and associated geometry is described in Sec. 6.1.5.

Figure 88: Feature from NIST CTC 5

The roundness_tolerance in cell C20 has the exact same associated geometry as datum feature ‘A’.
therefore, the FCF appears correct and is colored green.

Trailing and leading zeros are ignored when matching a PMI annotation to the expected PMI. Matches
also only consider the current capabilities of PMI in STEP AP242 and CAx-IF Recommended Practices.
For example, PMI annotation symbols for counterbore, countersink, and depth are ignored although they
might appear in the corresponding CAD model.

Some causes of partial and possible matches are:

missing associations of a geometric tolerance with a datum feature or dimension

missing diameter and radius symbols

wrong feature counts for repetitive dimensions

wrong dimension or tolerance zone values

missing or wrong values for dimension tolerances

missing or wrong datum reference frames

missing datum features

missing or incorrect modifiers for dimensions, tolerance zones, and datum reference frames
missing composite tolerances
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6.6.2 Representation Coverage Analysis

The PMI Representation Coverage worksheet is color-coded by the expected number of PMI elements for
a NIST test case. The expected number of PMI elements was determined by manually counting them in
each test case drawing, similar to Figure 51, for the NIST test cases. The color-coded worksheet is shown
in Figure 89. A similar worksheet without color-coding is shown in Figure 70.

If more or less than the expected number of PMI elements was found, then the first value of two is the
number found and the second is the expected number. For example, ‘2/3’ means that two PMI elements
were found when three were expected. Counting of some modifiers, e.g., maximum material condition in
row 24, does not differentiate whether the modifier appears in the tolerance zone definition or datum
reference frame.

A legend describing the colors is in column D of Figure 89.

A green cell is a match to the expected number of PMI elements.
e Cyan means that more were found than expected, e.g., ‘4/3’.
e Yellow, yellow-green, and orange mean that less were found than expected, e.g., ‘2/3’.
o Red means that no instances of an expected PMI element were found, e.g., ‘0/3’
e Magenta means that PMI elements were found when none were expected, e.g., ‘1/0’

In this example, there is one extra dimensional location (cell B13). This is also apparent from cell B11
which counts that total number of dimensions in cells B12 and B13. Cell B24 shows that the saved view
is missing.

A cell color other than green might mean that a CAD system or translator

did not or cannot correctly create in the CAD model, a PMI element defined in a NIST test case,
did not follow CAx-IF Recommended Practices for PMI [37],

has not implemented exporting a PMI element to a STEP file, or

mapped an internal PMI element to the wrong STEP PMI element.

Some of the NIST test cases have complex PMI annotations that are not commonly used. There might be
ambiguities in counting the number of PMI elements.

6.6.2.1 Color-coding Expected PMI

From the PMI Representation Summary results in Figure 87, color-coded percentages of exact, partial,
and possible matches to Expected PMI and missing PMI is shown in a table below the PMI
Representation Coverage Analysis in Figure 89 in rows 29 through 35. The Total PMI on which the
percentages are based on is also shown. Coverage Analysis is only based on individual PMI elements.
The PMI Representation Summary is based on the entire PMI feature control frame and provides a better
understanding of the PMI. The Coverage Analysis might show that there is an exact match for all of the
PMI elements, however, the Representation Summary might show less than exact matches.

For example, if a STEP file has the correct number of dimensions, the dimension PMI elements will be
colored green. This does not mean that the dimension values are correct. Those incorrect dimension
values are not reflected in the PMI Coverage Analysis. Incorrect values would show up as partial or
possible matches in Figure 87. Those partial or possible matches would show up in the second table in
Figure 89.
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nist_ctc_ 03 _asmel_ap242.stp
(2014-12-19T16:21:44+01:00)

Values as Compared to NIST Test Case Drawing
See Help > Analyze » NIST CAD Models

More than expected

Exact match

Less than expected (upper third)

Less than expected (middle third)

Less than expected (lower third)

None (0/n)

Unexpected (n/0)

Not checked

PMI Element
(See Help » Analyze = PMI Coverage Analysis) Count

angularity_tolerance £ 1
flatness_tolerance OJ 1
perpendicularity_tolerance | 2
position_tolerance & &
surface_profile_tolerance — 3
tolerance zone diameter (6.9.2) 7
unit-basis tolerance (6.9.6) 1
dimensions (location+size) 10/9
dimensional location (5.1.1) 2
dimensional size (5.1.5) 8/7
directed dimension = (5.1.1} 1
repetitive dimensions 'nX' (5.1, User Guide 6.1.3) 2
dimension association to geometric tolerance (5.1) 8/7
bilateral tolerance (5.2.3) 8
diameter @ (5.1.5) 8/7
linear distance (5.1.1) 2
reference dimension (5.3) 1
datum (6.5) &
datum system (6.9.7) 11
datum feature association to geometric tolerance (6.1) 8
maximum_material_requirement @ (6.9.3 0r6.9.7) 4
saved views (9.4) 0/1

Section numbers above refer to the CAx-IF Recommended Practice for Representation and Presentation of PMI (AP242)

Expected PMI
(See PMI Representation Summary worksheet) %

Exact match 96
Partial match 4
Possible match 0
Missing match 0
Mo match 4
Total PMI 28

Figure 89: Color-coded PMI Representation Coverage worksheet
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7  Syntax Checker

The Syntax Checker checks for basic syntax errors and warnings in the STEP file related to missing or
extra attributes, incompatible and unresolved entity references, select value types, illegal and unexpected
characters, and other problems with entity attributes. Some errors might prevent SFA and other software
from processing a STEP file.

There should not be any of these types of syntax errors in a STEP file. Errors should be fixed to ensure
that the STEP file conforms to the STEP schema and can interoperate with other software. There are
other validation rules defined by STEP schemas (where, uniqueness, and global rules, inverses, derived
attributes, and aggregates) that are not checked. Conforming to the validation rules is also important for
interoperability with STEP files.

The Syntax Checker can be run with function key F8 or when a Spreadsheet or View is generated. The
Status tab might be grayed out when the Syntax Checker is running. The Syntax Checker works with any
supported STEP schema.

Syntax checker results appear in the Status tab. If the Log File option is selected, the results are also
written to a log file myfile-sfa-err.log. The syntax checker errors and warnings are not reported in the
spreadsheet.

The Syntax Checker can also be run from the command-line version (Sec. 9) with the command line
argument ‘syntax’. For example: sfa-cl.exe myfile.stp syntax

Syntax Checker errors and warnings are unrelated to those reported when CAx-IF Recommended
Practices are checked with one of the Analyze options as described in Sec. 6.5.

Figure 90 is an example of syntax checking results. The number in parentheses is the line number in the
STEP file where the error or warning was detected.

Syntax Checker results for: C:/Users/test/Documents/syntax-err.stp
Generated by the NIST STEP File Analyzer and Viewer

syntax-err(13497): error: Reference to #4418 is geometric_curve_set, not compatible with representation.
syntax-err(14027): error: Reference to #4451 is geometric_curve_set, not compatible with representation.
syntax-err(20059): warning: Illegal control directive in string.

syntax-err(20060): error: Expecting ',', found _3DV instead.

syntax-err(20060): warning: Illegal character "' in enum.

syntax-err(28060): warning: Illegal hyphens in keyword BS7752-1.

syntax-err(28068): warning: Unexpected character "{'.

syntax-err(28068): warning: Unexpected character "}'.

syntax-err(22973): error: Reference to #4451 is geometric_curve_set, not compatible with representation.
syntax-err(22976): error: Reference to #4451 is geometric_curve_set, not compatible with representation.
syntax-err(68577): error: Reference to #67531 is axis2 placement_3d, not compatible with representation_map.
syntax-err(68577): error: Reference to #67533 is representation_map, not compatible with representation_item.
syntax-err(68579): error: Reference to #4191 is geometric_curve set, not compatible with representation.
syntax-err(68588): error: Reference to #67531 is axis2 placement_3d, not compatible with representation_map.
syntax-err(68580): error: Reference to #67536 is representation_map, not compatible with representation_item.
syntax-err: warning: Unresolved reference to instance #19750.

syntax-err: warning: Unresolved reference to instance #19751.

syntax-err: warning: Unresclved reference to instance #19752.

syntax-err: warning: Unresoclved reference to instance #19753.

syntax-err: warning: Lowercase letters used in keywords. (8 occurrences)

Figure 90: Syntax Checker results
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8 Multiple STEP Files

Processing multiple STEP files at once is an easy way to process many STEP files with only a few mouse
clicks and to compare entity usage and coverage of PMI representation and presentation across multiple
STEP files.

There are two ways you can select multiple STEP files. The first is to wuse the
Open Multiple STEP Files in a Directory option from the File menu as shown in Figure 4. You can select a
directory in which all STEP files in that directory will be processed. Subdirectories of the selected
directory can also be searched. The other way is to select multiple individual STEP files when using the
Open STEP File(s) option from the File menu. Multiple STEP files can be selected in the Open STEP
File(s) dialog by holding down the control or shift key when selecting files.

8.1 Summary Worksheet

When processing multiple STEP files, a second spreadsheet is generated in addition to the individual
spreadsheets for each STEP file. The second spreadsheet contains a summary worksheet of the entities
found in the multiple files and possible coverage worksheets for PMI representation and presentation as
shown in Figure 91. In this example five STEP files were processed. Starting after row 9, column A lists
all of the entity types in all five files. All of the entities (rows) are not shown. The entities in column A
are grouped and colored according to the categories of entities in the Process section of the Options tab.
Columns B through F contain the entity counts for each of the five STEP files. Column G is the total
entity count for all of the files and column H is the total number of files that an entity appears in.

Row 1 is the top-level directory where all of the STEP files are located. Row 3 contains links to the
individual spreadsheets. Row 4 contains the name of the STEP file and a link to it. The file name can
also contain the file’s subdirectory. Clicking on the STEP file link will show it in whatever program is
set to open STEP files (.stp file extension) on your computer. The links in rows 3 and 4 can be turned off
in the Spreadsheet tab with the selections for Excel Options. Rows 5 through 9 contain, respectively, the
file timestamp, software that generated the STEP file (blank in this example), the STEP AP from the file,
the size of the STEP file, and the number of entities in the STEP file.

The gray cell B34 with the comment indicates that there is at least one perpendicularity_tolerance entity
that has an error or warning (Sec. 6.5).
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A B C D E F G H

STEP Directory C:\Users\lipman\Documents\Analyzer\User Guide
2
3 Link (1) = Link(2) @ Link(3) | Link(4) @ Link (5]
[+ 8 [+ 8 [+ 8 [+ 8 [+ 8
ol ol ol ol ol
m m m @ m
— — — — —
2 2 2 2 2
m m m m m
— ™ m =T n
o o o o o
L% L% L% L% L%
i1 i1 i1 i1 i1
. 4] @ @ @ 4]
5 15-02-16 15-02-17 14-12-19 15-02-16 14-12-19
6
7 AP242el AP242e2 AP242el AP242el AP242el
8 390KE 2381KEB 1261KBE 1073 KB 857KB
Total Total
g Entity 6139 45646 17312 17926 13400 |Entities Files
(geometric_tolerance_with_datum_reference)
2 9 2 3 16 4

(surface_profile_tolerance)
(geometric_tolerance_with_datum_reference)

(surface_profile_tolerance) 3 3 1
32 (unequally disposed _geometric_tolerance)
(geometric_tolerance_with_modifiers)

93}

1 1 1
33 Ik Tee ) «"[There are Errors or Warnings for at least one entity of this type. |
34 perpendicularity_tolerance =) Z Z Z 7 T
35 placed_datum_target_feature 9 2 11 2
35 plus_minus_tolerance 6 7 8 7 2 30 5
37 roundness_tolerance 1 1 1
38 shape_dimension_representation 8 7 10 9 6 a0 5
35 straightness tolerance 1 1 1
40 surface_profile_tolerance 1 1 2 2
47 tolerance_value 6 7 8 7 2 30 5
42 tolerance_zone 7 7 3 1 18 4
43 tolerance_zone form 7 7 3 1 18 4
44 total_runout_tolerance 2 2 1
453 annotation_curve occurrence a6 30 22 98 3
45 annotation_plane 22 a6 4 25 7 104 5
47 camera_model_d3 1 11 1 2 15 4
(characterized_representation)
. 2 2 2 7] 3
48 [draughting_model)
4% colour 45 4 50 2
30 colour rgb 1 3 156 2 7 169 5
37 curve_style 1 Ly 30 1 84 5
52 draughting_callout 22 25 22 69 3
3% draughting_model 12 1 1 14 3
54 draughting_model_item_association 34 136 59 37 16 312 5
35 draughting_pre_defined_colour 1 1 30 1 1 34 5
3¢ draughting_pre_defined curve font 1 a7 30 1 5 84 5

File Summary PMI Representation Coverage )

Figure 91: File Summary worksheet, multiple files (rows 31-56)

8.2 Coverage Analysis Worksheets

If PMI representation or presentation is found in the STEP file, then coverage analysis worksheets are
generated.
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8.2.1 PMI Representation Coverage Analysis

Figure 92 and Figure 93 shows the worksheet that is generated for coverage analysis of PMI
representation. The information on the worksheet is the same as described in Sec. 6.1.7. Columns B
through F refer to five STEP files and contain the number of occurrences of that PMI element. Column G
counts the total number of occurrences for all STEP files that contain that type of PMI element. In this
example the cells are color-coded, as described in Sec. 6.6, because all five STEP files were generated
from the NIST CAD models.

A B C D E F G
C:\Users\lipman\Documents\Ana
2

j= 1 o j= 1 j= 1 o

% " % B "
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= = =t =t =

™ ™ ™ ™ ™

o [« j= 1 j= 1 [«

m m m m m

U 1] u u 1]

E E E E E

[} m 1] 1] m

ORI

L= ™ m =+ L

(=] (=] = = (=]

588 98

PMI Element (R I (A

. B B B B
3 | {See Help > Analyze > PMI Coverage Analysis) © £ © £ < |Total PMI
4 |angularity_tolerance £ 1 1
5 |circular_runout_tolerance A 3 3
& |coaxiality tolerance @ 1/0 1
7 |concentricity_tolerance & 0/1 0
8 |flatness_tolerance J 1 1 1 3
9 |line_profile_tolerance — 1 1
10 |perpendicularity_tolerance | 1 3 2 2 8
11 position_tolerance & 2 4 & 3/4 15
12 roundness_tolerance () 1 1
13 straightness_tolerance — 1 1
14 |surface_profile_tolerance o~ 2 13 3 3 21
15 total_runout_tolerance 2 2
16 |tolerance zone diameter (6.9.2) 7 7 341 18
17 |all_around = (6.4.2) 1 1
18 |projected B (6.9.2.2) 0/1 1]
19 unequally_disposed @ or UZ (6.9.4) 3 3
20 |unit-basis tolerance (6.9.6) 1 1
21 |composite tolerance (6.9.9) 2 2
22 dimensions (location+size) 7 7 10/9 89 6 38
23 |dimensional location (5.1.1) 2 2/3 5 9
24 |dimensional size (5.1.5) 7 7 87 6 1 29
25 |angular location (5.1.2) 1 1/0 2
26 angular size (5.1.6) 0/1 0
27 |directed dimension = (5.1.1) 1 1
28 |derived shapes dimensional location (5.1.4) 1 1
29 repetitive dimensions 'nX' (5.1, User Guide 6.1.3) 0f2 2 3/s 5
30 dimension association to geometric tolerance (5.1) 5/7 8/7 2/30f1 15
31 |dimension precision (5.4) 6 6
32 |bilateral tolerance (5.2.3) 2 7 8 7 2 26
33 |non-bilateral tolerance (5.2.3) 4 4
34 |value range (5.2.4) 2 2

File Surmmary PMI Representation Coverage ()

Figure 92: PMI Representation Coverage worksheet, multiple files (rows 1-34)
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35 |diameter @ (5.1.5) 7 7 8/75/6 1 28
36 linear distance (5.1.1) 2 2 5 9
37 |curve length (5.1.5) 1
32 /dimension basic(5.3) 2 4
39 |reference dimension (5.3) 1 1
40 |datum (6.5) 3 10 6 8 4 31
41 |datum system (6.9.7) 5 20 11 6/7 8 50
42 |multiple datum features (6.9.8) 3/1 3
43 |datum feature association to geometrictolerance (6.1) |1 6 8 1/2 16
44 |all datum targets 9 2 11
45 |point datum target (6.6.1) 8 2/0 10
48 [rectangle datum target (6.6.1) 0/2 ]
47 |circle datum target (6.6.1) 1 1
42 |least_material_requirement © (6.9.3 or 6.9.7) 7 7
48 |maximum_material_requirement @ (6.9.3 or 6.9.7) 5 4 9
50 |statistical_dimension <ST= (5.3) 1 1
51 |saved views (9.4) 1 3 0f1 1 2 7
52 |150 modeling standard (4, Fig. 2) 1 1
53
54 |Section numbers above refer to the CAx-IF Recommended Practice for Representation and
55

Expected PMI
56 | (% from PMI Representation Summary worksheets)
57 |Exact match 94 B8 96 73 B3
58 |Partial match 0 12 4 18 4
53 |Possible match 6 0 0 0 4
60 |Missing match 0 0 0 8
61 |Mo match 12 12 4 5 17
62 Total PMI 17 52 28 22 24

File Summary PMI Representation Coverage )

Figure 93: PMI Representation Coverage worksheet, multiple files (rows 35-62)
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8.2.2 PMI Presentation Coverage Analysis

Figure 94 shows the worksheet that is generated for coverage analysis of PMI presentation.

The

information in the worksheet is the same as described in Sec. 6.2.1. Columns B through F refer to five
STEP files and contain the number of occurrences of that PMI presentation name. Column G counts the
total number of occurrences for all STEP files that contain that name.

1
2

WO 00 |~ | LA e (W

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37

H

| 1 K

A B|C|[D|E|F G
STEP Directory C:\Users\lipman\Documents\Analyzer\User-Guide
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PMI Presentation Names | © © © £ T [Total PMI
angularity 1 1
circular runout 3 3
circularity 1 1
coaxiality
concentricity 1 1
cylindricity
flatness 1 1 1 3
parallelism
perpendicularity 1 3 2 2 8
position 2 4 a6 3 15
profile of line 1 1
profile of surface 2 13 3 2 20
roundness
straightness 1 1
symmetry
total runout 2 2
general tolerance
linear dimension 2 2 4 6 14
radial dimension
diameter dimension 7 7 8 28
angular dimension 1 2
ordinate dimension
curve dimension
general dimension
datum 3 15 6 8 2 34
datum target 2 2
note 1 1
label 301 1
surface roughness
weld symbol
general note
over riding style set

Presentation Names defifed in Representation and Presentation of PMI (AP242), Sec. 8.4, Table 14

File Summary

PMI Representation Coverage

PMI Presentation Coverage

Figure 94: PMI Presentation Coverage worksheet, multiple files
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9 Command-line Version

A command-line (console) version of SFA is available (sfa-cl.exe) that can be run from a Windows
command prompt. SFA can also be accessed by or embedded in other programs. The command-line
version will use the options that were last used in the GUI version of SFA. Figure 95 shows the options
available for the command-line version.

EX Command Prompt

MIST STEP File Analyzer and Viewer

Usage: sfa-cl.exe myfile.stp [csv] {[view]|[stats]|[syntax]} [noopen] [nolog] [file]

Optional command line settings:

csv Generate CSV files

view Only generate Views and no Spreadsheet or CSV files

stats  Only report characteristics of the STEP file, no output files are generated

syntax Only run the Syntax Checker

noopen Do not open the Spreadsheet or View after it has been generated

nolog Do not generate a Log file

file Mame of custom options file, e.g., C:/mydir/myoptions.dat This file should
be similar to STEP-File-Analvzer-options.dat in yvour home directory.

Most options last used in the GUI version are used in this program unless the 'file'
option is used.

Figure 95: Command-line version options

To facilitate running the command-line version, the PATH environment variable can be set to include the
directory where the command-line executables are located. A batch file can also be created to run the
command-line executable. If the STEP file is not located in the same directory as the command-line
executable, then the STEP file name should also include the directory pathname for the file. When the
command-line version is run, feedback is provided that is similar to what is shown in the Status tab as
shown in Figure 96. Error and warning messages are preceded with asterisks (*) and highlighted with a
different font and background color.
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E¥ Command Prompt — O x

NIST STEP File Analyzer and Viewer
Reading options file: C:\...\STEP-File-Analyzer-options.dat

#** Begin ST-Developer output
ST-DEVELOPER
System Release v1@

Copyright (c) 1991-2883 by
STEP Tools Inc., Troy, New York
All Rights Reserwved

*** End S5T-Developer output
IOpening STEP AP242 file
#+* Begin ST-Developer output

Reading: C:\Users\lipman\Documents\AnalyzeriUser Guide\nist_ctc_83_asmel_ap242.stp

Reading: C:\PROGRA~2\IFCsvrR3@8\dll\header_section_schema.rose

Reading: C:\PROGRA~2\IFCsvrR3@8%\dll\ap242_managed_model_based_3d_engineering_mim_lf.rose

Reading: C:\PROGRA~Z\IFCsvrR38@%d11\keystone_extensions.rose

nist_ctc_83_asmel_ap242(7): "ListOfblend_radius_variation_type": Best-fit class is "RoseEnumlList™.
nist_ctc_@3_asmel_ap242(7): "SetOfgeometric_tolerance_modifier": Best-fit class is "RoseEnumSet™.
nist_ctc_@3_asmel_ap242(7): "SetOfgeometric_tolerance_modifier”: Best-fit class is “RoseEnumSet™.
nist_ctc_83_asmel_ap242(7): "ListOfa3m_element_type_name": Best-fit class is "RoseEnumlist".
nist_ctc_83_asmel_ap242(7): "ListOfa3m_detected_difference_type_name": Best-fit class is "RoseEnumlList™.
nist_ctc_@3_asmel_ap242(7): "ListOfa3m_accuracy_type_name™: Best-fit class is "RoseEnumlist™.
nist_ctc_@3_asmel_ap242(7): "SetOfsummary_report_style_type": Best-fit class is "RoseEnumSet™.

*** End ST-Developer output

17312 entities
This file contains: Datums, Dimensions, Geometric tolerances, Graphical PMI (polyline), Part geometry, Supplemental geom
etry

|Generating Header worksheet

Mame: nist_ctc_83_asmel_ap242

FileDirectory: C:\Users\lipman‘\Documents‘\Analyzer\User Guide

FileDescription: CTC-83 geometry with PMI representation and/or presentatien, from the NIST MBE PMI Validation and Conf
ormance Testing Project, https://go.usa.gov/mGVm

FileImplementationLevel: 2;1

FileTimeStamp: 2814-12-19T16:21:44+81:88

FileAuthor:

FileOrganization:

FilePreprocessorVersion:

FileOriginatingSystem:

FileAuthorisation:

SchemaMame: AP242_MANAGED_MODEL_BASED_3D_ENGINEERING_MIM_LF {1 @ 18383 442 1 1 4 } (Edition 1)

Reading Expected PMI Representation Coverage

lGenerating STEP Entity worksheets
dimensional_characteristic_representation (18)
Adding PMI Representation Analysis

datum (6}

datum_feature (6)

Adding PMI Representation Analysis
datum_reference_compartment (28)
Adding PMI Representation Analysis

datum_system (&)

Adding PMI Representation Analysis
dimensional_location (1)
dimensional_size (8)

Figure 96: Command-line version output
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